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    Safety Information
Before you use your Trimble product, make sure that you have read and understood all safety 
requirements.

WARNING – This alert warns of a potential hazard which, if not avoided, could result in severe injury or even 
death.

CAUTION – This alert warns of a potential hazard or unsafe practice that could result in minor injury or property 
damage or irretrievable data loss.

Note – An absence of specific alerts does not mean that there are no safety risks involved.

Use and care
This product is designed to withstand the rough treatment and tough environment that typically 
occurs in construction applications. However, the receiver is a high-precision electronic instrument 
and should be treated with reasonable care.

CAUTION – Operating or storing the receiver outside the specified temperature range can damage it.

Vehicle safety
WARNING –When you select the Vehicle mode, the following warning message appears:

WARNING: Do not operate SCS900 while driving the vehicle. Failure to heed this warning may result in a 
collision causing property damage or personal injury.

Do not interact with the touch screen, keyboard, or software in any way while the vehicle is moving. While the 
vehicle is moving, the software provides a continuous display of position and data that can be seen at a glance. 
Operating the device or interacting with the software while the vehicle is moving can be a distraction for the 
operator, and may result in collision causing property damage or personal injury.

Servicing
Do not attempt to repair a Trimble Site Tablet or Trimble TSC3 controller. There are no user-
serviceable parts inside. To arrange for a controller to be serviced, please contact your Trimble 
dealer.
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Safety Information

Accessories
Caution – Use only approved accessories with this equipment. In general, all cables must be high quality, 
shielded, correctly terminated, and normally restricted to two meters (6.56 feet) in length. AC adapters approved 
for this product have special provisions to avoid radio interference and must not be changed or substituted. 
Unapproved modifications or operations beyond, or in conflict, with these instructions for use may void 
authorization by the authorities to operate the equipment
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1   Introduction

In this chapter: 

 n Related information

 n Technical support

This manual provides you with the necessary 
information to perform measurement tasks with 
the Trimble® SCS900 site controller software. To 
perform these measurement tasks, you need the 
SCS900 site controller software running on a 
controller that is either connected to a Precision or 
Location GNSS system, or to a total station. You 
can also use the internal GPS of the device to 
locate objects. The SCS900 software is the field 
software that runs on a Trimble Site Tablet and the 
Trimble TSC3 controller. For presentation and 
training purposes, a software emulator that runs 
on a Windows operating system is also available.

The SCS900 software is a site measurement tool 
that streamlines earthworks and surface finishing 
operations. It enables construction contractors to 
measure material volumes, monitor grades and 
laid material thicknesses, and to perform site 
measurement tasks such as point, line, and 
surface stakeout.

Start up and set up of the sophisticated GPS and 
total station technology is quick and easy. The 
software manages data for multiple project sites, 
single large project sites, and large sites that have 
been divided into zones. When a field engineer 
opens a work order, the software opens all data 
files needed to complete that work order. Because 
the software delivers results immediately, 
informed decisions can be made in the field.

The software can also be used to check site 
grading operations that have been performed 
using a machine control system, such as a Trimble 
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1   Introduction

GCS900 grade control system. If your organization does not have a 3D machine control system, the 
system provides site control, grade control, progress volumes, and stakeout capabilities to facilitate 
earthmoving operations.

The field engineer can quantify progress, check data, and set out the information needed to keep  
the machines moving. The SCS900 system tracks activities at each site and keeps a continuous 
record of all results. Related data is stored, together, as a permanent construction record and is also 
output as a TXT or DXF file. Back at the office, the software delivers comprehensive operation 
analysis data.

Even if you have used other GNSS or GPS products before, Trimble recommends that you spend 
some time reading this manual to learn about the special features of this product. If you are not 
familiar with GNSS or GPS, visit the Trimble website (www.trimble.com).

Related information
Sources of related information include the following:

 l Release notes – The release notes describe new features of the product, information not 
included in the manuals, and any changes to the manuals. They can be downloaded from the 
Trimble website at www.trimble.com/construction/heavy-civil/site-positioning-
systems/scs900.aspx?dtID=support.

 l Trimble training courses – Consider a training course to help you use your GNSS system to its 
fullest potential. For more information, go to the Trimble website at 
www.trimble.com/Support/Index_Training.aspx.

Technical support
If you have a problem and cannot find the information you need in the product documentation, 
contact your local dealer. Alternatively, go to the Support area of the Trimble website 
(www.trimble.com/Support/). Select the product you need information on. Product updates, 
documentation, and any support issues are available for download.
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2   Starting the Software

In this chapter: 

 n System information
To start the SCS900 software on your controller, 
tap Start and then select Trimble SCS900. The 
SCS900 software will start in the Open Site dialog 
where you can select an existing site, design, and 
work order on your controller or create a new one.

After accepting the selection, the software loads 
your data and the map view. If you have 
previously connected a rover receiver to the site 
base station, the software tries to automatically 
connect with the last used configuration.
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2   Starting the Software

If the software is not automatically connecting to your positioning device, go to the Home menu 
and tap GPS or Total Station to start the setup.

System information
The System Information dialog has multiple tabs that contain information about the current version 
of the SCS900 software, which modules are enabled, which positioning sensors are connected and 
which firmware the sensors have. From the Trimble icon menu, select System Info.

If you have purchased a module after the controller was activated, activate the new module by 
tapping Update License in the Modules tab.
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2   Starting the Software

In the Regional tab, you can toggle between different supported languages:
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3   Menus

In this chapter: 

 n The Home menu

 n The Site menu

 n The GPS menu

 n The Total Station menu

 n The Import/Export menu

 n The Measure menu

 n The Stake menu

 n The COGO menu

 n The Exit menu

The software is a menu-driven system. From the 
Map screen you can access the main menu 
through the Home button at the bottom left of 
the screen. The Trimble icon menu next to it 
contains related functions to the mode currently 
in use.
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3   Menus

The Home menu
The Home menu is the main menu of the SCS900 software. It contains the following buttons:

To access it, tap .
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3   Menus

The Site menu

The Site menu contains the tools to create, open, and complete sites, designs, and work orders. You 
can also change the design referenced by the current work order, and create new designs.

From the Home menu, tap Site.

You can create a new site, design, and work order. At the top of each list, the software displays the 
last three items that have been used and then all remaining data on the controller:
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3   Menus

The GPS menu

The GPS menu contains the control and system setup functions for GNSS operation. Use this menu 
to start the rover receiver, carry out a site calibration, or select a predefined coordinate system. You 
can also enter and edit control point information, measure new control points for the project, and 
recheck the system setup on a control point.

From the Home menu, tap GPS.

The following commands are available from this menu:

Command Description

Set up and start a GNSS base station, rover receiver, configure 
static measurements, or start the internal GPS of the controller.

Perform or resume a single-point, two-point, or multi-point site 
calibration. 

Select a predefined coordinate system from the coordinate 
system library.

Check an existing site calibration on a known control point.

Edit and enter control point coordinates.

Measure new control points.
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3   Menus

The Total Station menu

The Total Station menu contains the control and system setup functions for total station operation. 
Use this menu to connect the instrument and carry out total station setup to establish the position 
and orientation of the instrument. The menu provides access to all total station control functions. 
General functions include being able to enter and edit control point information, measure new 
control points for the project, and recheck the system setup on a control point.

From the Home menu, tap Total Station.

The following commands are available from this menu:

Command Description

Connect to the total station using either a cable, Bluetooth® wireless 
technology, or a radio  for robotic operation.

Set up the total station and establish its position and orientation on the site 
using the known point or arbitrary location (also known as free station or 
resection) methods. 

Set up for machine control.

Check an existing site calibration on a known control point.

Calibrate a total station.
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Command Description

Change the settings of a total station setup.

Edit and enter control point coordinates.

Measure new control points.

Set up the software for stockpile scanning.
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3   Menus

The Import/Export menu

Use this menu to export measured information or selected design information to an external 
memory device such as a USB flash drive. It also includes export functions for data use in the GCS900 
or AccuGrade grade control systems.

From the Home menu, tap Import/Export.

The following commands are available from this menu:

Command Description

Write the surface data that was measured in the field to a new design surface.

Export measured data in a CSV File or in a DXF File, write the measured data in a 
Record.txt file, or export data as a custom report using a stylesheet template.

Export a design to a CompactFlash card or USB drive for use with the GCS900 
Grade Control System.

Synchronize data with the Connected Community service using the Wireless 
Data Sync function.

Enter the device credentials to access the Connected Community service.
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3   Menus

The Measure menu

The software always initially starts in the Measurement mode. Use this option to switch between 
stakeout and measure.

From the Home menu, tap Measure.

In this menu, you can accomplish all site measurement functions including:

 l Grade checking

 l Material thickness checking

 l Topographic measurements to create surface models (for example, volume computations)

 l Site feature measurements to record the location of non-surface features

 l Real-time cut/fill information against a selected design model

Before you use this menu, set up your GPS or total station function in the Home menu. If you have 
not yet done a system setup when you select an option in this menu, the software automatically 
puts you through either the station establishment process for a total station, or the rover setup for 
GNSS.

If points or lines are stored as part of a DTM surface or only as a site feature, they can be defined in 
the Measure Typedialog to the left of the status bar. When the Advanced Measurement module is 
installed, the measurement type is controlled by the settings in the Feature Code Library for each 
feature code.
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3   Menus

The Stake menu

The Stake menu contains all stakeout functions including staking points, lines and alignments, 
surfaces, side slopes, catch points, and road features. Before you use this menu, set up the system 
using the System Setup menu.

From the Home menu, tap Stake.

After selecting the stakeout function, the object selection screen appears. Select the object that you 
want to stake out either directly from the map or from the list in the top right corner of the screen 

.

After you select an object, multiple stake methods are available that differ depending on the type of 
object that you selected. For more information, see Stakeout Workflow, page 68.
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3   Menus

The COGO menu

The Volume & COGO menu contains a number of calculations, for example, area, distance, bearing, 
slope, and point generation functions that can be used to generate points for stakeout operation 
from CAD data in the currently loaded design. The menu also provides access to review and edit 
functions for editing breaklines and deleting points or lines to resolve surface modeling problems.

From the Home menu, tap COGO.

The following commands are available from this menu:

Command Description

View or delete point and lines, add breaklines and boundaries, and calculate 
surface volumes (stockpiles) or periodic progress volumes. 

Create points by a variety of methods including free point, radius, and offset to a 
line. To create free points, tap the screen or enter its coordinates. 

View all stakeout points of the currently selected design and edit their 
coordinates.

Enter a basic road alignment and road cross sections in the field. This function 
requires the SCS900 Roading module.

The Exit menu

This menu closes the SCS900 software, and optionally can shut down the receiver.

From the Home menu, tap Exit SCS900.
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4   Measurement screen

In this chapter: 

 n Measure modes

 n Status bar

 n Precision GNSS control icons

 n  Map options

 n The Total Station menu

 n Toggling between plan and cross section 
view

 n Info bars

 n Antenna Height / Target Height

 n Trimble icon menu

The software is a menu-driven system. From the 
Map screen you can access the main menu 
through the Home button at the bottom left of 
the screen. The Trimble icon menu next to it 
contains related functions to the current mode in 
use.
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4   Measurement screen

Measure modes
The Measure mode controls a number of functions for the GPS receiver and total station. There are 
multiple modes available, which you can switch between by tapping the Measure Mode icon on the 
left side of the status bar or in the Trimble icon menu in the Measure Mode option.

GPS measure mode

GPS measure 
mode

Name Description

Standing Walk to a point and then take a single measurement.

Walking Walk the site and continuously take measurements. Points 
are stored based on a setting for horizontal distance and 
elevation change, which can be set by tapping the Measure 
mode icon either in the status bar or in the Trimble icon 
menu. 

Vehicle Drive the site in a vehicle. Points are stored based on a setting 
for horizontal distance and elevation change, which can be set 
by tapping the Measure mode icon either in the status bar or 
in the Trimble icon menu.

Static Measure a point for a longer period and to achieve a greater 
accuracy. 

Total Station measure mode

Total Station 
measure mode

Name Description

Standing Walk to a point and then take a single measurement.

Walking Walk the site and take continuously measurements. Points 
are stored based on a setting for horizontal distance and 
elevation change, which can be set by tapping the Measure 
mode icon either in the status bar or in the Trimble icon 
menu. 

Vehicle Drive the site in a vehicle. Points are stored based on a setting 
for horizontal distance and elevation change, which can be 
set by tapping the Measure mode icon either in the status 
bar or in the Trimble icon menu.

Averaging Measure a point in multiple faces/rounds.

DR Measure a point using a DR reflectorless total station.
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4   Measurement screen

Status bar
The status bar at the bottom of the screen contains relevant information about the current status 
of the positioning system, battery status, measure mode, and measurement type. The icons change 
slightly depending on the positioning device. The following icons are typically available:

GPS mode

Icon Description

Indicates the current measure mode in use. See Measure modes, page 25

The number of satellites being tracked and radio connection status to the base 
station.
The horizontal and vertical precision of the GPS position solution.

The battery level of the controller and externally connected GNSS receiver. 

Cell signal reception for the internal cell modem.

Measurement type (Point, Line, Surface Feature).

Random/Fixed station mode staking.

Stake method.

Total Station mode

Icon Description

Indicates the current measure mode in use. See Measure modes, page 25.

Target tracking status and access to the control panel.

Shows the battery level of the controller and total station.

Cell signal reception for the internal cell modem.
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4   Measurement screen

Icon Description

Measurement type (Point, Line, Surface Feature).

Random/Fixed station mode staking.

Stake method.

Precision GNSS control icons
When using the internal GPS or while connected to an external SPS receiver, an icon panel appears 
at the bottom of the screen. The display swaps permanently between the following two panels:

 

GPS mode

This icon… Shows…

how many satellites are being tracked.

the radio connection status.

the battery level of the controller.

the battery level of the GNSS receiver.

the horizontal and vertical precision of the GPS position solution.
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4   Measurement screen

Tap one of these icons to show more detailed information. To access the sky plot of the current 
satellite constellation, tap the Satellite icon:

The icons in the sky plot represent the following satellite constellations:

This icon… Shows…

GPS
BeiDou
Galileo
GLONASS
QZSS
SBAS

The Tolerances button, which appears when the controller is connected to an SPS receiver, is a 
shortcut to the RTK Precision option. The GPS Only check box enables you to toggle between using 
GPS and GNSS.
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4   Measurement screen

Map options

Map options enables you to customize what you see on the map. You can choose the information 
that you want to view for the task rather than cluttering the screen with too much information.

Map control
The icons on the right of the screen enable you to move around the screen and toggle information 
on and off to improve readability when there is a lot of information shown on the screen.

Icon Description

Center the map on the current location.

Zoom to the extents of the file.

Zoom to a user-defined box (use a stylus to draw a box on the screen).

Zoom in.

Zoom out.

View the display options.

Toggle between the Plan and Cross Section view when staking lines and roads.
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4   Measurement screen

Measure tab
Use the Measure tab to filter the different measured data that is being displayed:

Select this option… to display…

Point names the point names of every point on the map view.
Point elevations the point elevations of every point on the map view.
Control points control points on the map view.
Measured surface measurements that were recorded as a surface.
Coverage grid a coverage map that shows cut/fill in tolerance values as red/blue/green or 

different shades of blue to represent elevation changes depending on the 
setting of the radio button.  

Point codes the point codes of every point on the map view.
Point cut/fill the cut/fill information for every point on the map view.
Stakeout points stakeout points on the map view.
Measured feature measurements that were recorded as a site feature.
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4   Measurement screen

Design tab
Use the Design tab to filter the different design data types that are displayed:

Select this option… to display…

Design map the design map on the map view.
Guide arrow the guidance arrow to navigate to points of interest.
Design contours contours on the map view, if a design is loaded.
Roadway the center line of any roadway design.
Display cross-section display the slope values for each segment of a road cross section.
Site maps the site map on the map view.
Stakeout flags stakeout flags on the map view.
Cross section lines the cross sections of any loaded roadway design.
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4   Measurement screen

Layers tab
If there is a lot of data displayed, use the Layers tab to turn layers on and off in the design map to 
improve readability.
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4   Measurement screen

Rotate tab
Use the Rotate tab to control the map rotation of the Measurement screen:

Select this option… to orientate…

Static the map view to North.
Travel direction the map view to your direction of travel/walking.
Follow alignment (This option is only available when an alignment is selected.)
Up station the screen up station.
Down station the screen down station.

Note – When any option other than Static is selected, a North arrow automatically appears on the 
screen.
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4   Measurement screen

Toggling between plan and cross section view

If road or alignment data is loaded in the current design, a button on the bottom right of the screen 
enables you to toggle between plan and cross section view. A highlighted button shows that the 
cross section view is enabled.
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4   Measurement screen

Info bars
At the top of the screen there are two bars that show readings and values related to the current 
operation:

Use the arrows on the right and on the left to scroll through the different values which are currently 
enabled. You can also tap on the bar and "flick" through the different values. For each function, a 
predefined set of values is shown. You can modify the settings in the Trimble icon menu with the 
Configure Info Bars option. 

Some fields (for example, Antenna & Target Height, Stakeout line offset, and Surface offset) are 
"active" fields. By tapping on it, you can change the settings and shortcut in the Settings dialog of 
this value.

The following values are available:

This value Shows the…

Ant Ht  currently applied antenna height.
Tar. Ht currently applied target height.
E current Easting in the selected/applied coordinate system.
N current Northing in the selected/applied coordinate system.
Elv current Elevation in the selected/applied coordinate system.
Horizontal angle current horizontal angle the instrument is shooting.
Vertical angle current vertical angle the instrument is shooting.
Slope distance current slope distance the instrument is shooting.
Lat current latitude in WGS-84.
Long current longitude in WGS-84.
Ht current height in WGS-84.
Sta current station to a selected road or alignment.
Off current offset from a selected road or alignment.
Go distance and direction guidance to a selected point or object.
Cut/Fill cut/fill value to a selected point, line, road, or alignment.
Dsn Elv design elevation of a selected point, line, road, or alignment. An arrow next to 

the value indicates if a surface offset has been applied.
Thickness current thickness of a layer vertical on the last layer.
R. Sta current station to the selected reference alignment.
R. Off current offset to the selected reference alignment.
dE difference in East to a selected point or object.
dN difference in North to a selected point or object.
dElv difference in Elevation to a selected point or object.
Ahead/Back difference in station  to a selected point along the selected alignment.
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This value Shows the…

Inward/Outward difference in offset  to a selected point relative to the selected alignment.
Feature 2 cut/fill Cut/Fill 1–2 when using a primary and underlying surface.
Feature 2 design 
elevation

design elevation of a selected point, line, road, or alignment.

Dsn Sta station to a selected point per design.
Stakeout line offset 
H

currently-applied horizontal line offset.

Stakeout line offset 
V

currently-applied vertical line offset.

Surface offset currently-applied surface offset.
Cut/Fill 1 Cut/Fill values referenced to the primary surface.
Cut/Fill 2 Cut/Fill values referenced to the secondary surface.
Design Elevation 1 design elevation referenced to the secondary surface.
Design Elevation 2 design elevation referenced to the secondary surface.
Cut/Fill between 
surfaces

distance between the primary and secondary surface at this location.

Second surface 
settings

surface offset for secondary surface.

FXL code description for the selected feature code.

Antenna Height / Target Height
To change the antenna or target height, tap on the value in the info bar. This value is subtracted 
from each GPS elevation or elevation measured with a total station. If the antenna/target height is 
currently not displayed in the info bar, turn it on in the Trimble icon menu using the Configure Info 
Bars option.
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4   Measurement screen

Trimble icon menu
Tap the Trimble button   to directly access functions related to the current operation. A menu 
similar to the one shown below appears:

The content alters with the current function and available data.

Measure menu

Icon Description

Toggle between Standing, Walking, Vehicle, Static, and Averaging Mode.

Select a reference line or alignment to get station and offset in addition to 
the current function in use.

View the log file of the current work order.

System information about the software including any modules installed.
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Icon Description

Configure the info bar or adjust the stakeout settings, the Line settings, or 
the Road settings. It also enables you to select a secondary surface in a 
design in the same site.

Toggle between measuring points, lines, surface, and site features.

Generate a statistic about the quality of a surface grade check.

Stakeout menu

Icon Description

Toggle between Standing, Walking, Vehicle, Static, and Averaging mode.

Select a reference line or alignment to get station and offset in addition to 
the current function in use.

View the log file of the current work order.

System information about the software including any modules installed.
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Icon Description

Change the settings for the stake writer tool, for example, the 
dimensions of your stake and the stake marking method.

Configure the info bar or adjust the stakeout settings like settings for the 
stakewriter tool, the line settings, or the road settings.

Stake a different object.

Stake a point with a different design elevation.

Stake a different station.

Stake a feature with an offset.
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5   Data Management

In this chapter: 

 n Sites, Designs, and Work Orders

 n Avoidance zone settings

 n Creating and opening a work order in the 
field

 n Connected Community service

Trimble recommends that you use the latest 
version of the Business Center – HCE software to 
prepare the data that should be used with the 
SCS900 software. The Business Center – HCE 
software incorporates the capabilities of the SCS 
Data Manager and Report Utility for multiple 
jobsite/controller management and generating 
work order reports. The correct file folder 
structure is automatically created and quality 
assurance tools are available to ensure that all 
controllers are using the most recent data.
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Sites, Designs, and Work Orders
All data for the software is stored in a top-level folder called Trimble SCS900 Data, and is organized in 
a precise structure. The file folder structure that you create on the office computer exactly mirrors 
the file folder structure on the controllers, which makes it easy to manage and archive data between 
the computer and the controllers. Data is organized by site. Within each site, data is divided into 
designs and work orders.

Information on a controller is arranged in the following levels:

Level Description

Global Global information is used at all sites. It includes lists of feature codes, Code lists, 
and Geoid files.

Site Site information relates to all activities at the specified site. It includes control 
points, site calibration results, and background maps. Site information is always 
available.

Design Inside each site, a main Designs folder holds individual design folders that 
contain design data pertaining to the site. Design data relates to a particular 
phase of construction. Data stored at this level includes foreground maps, 
stakeout data, and a design surface model.

Work Order Inside each site, a main Work Orders folder holds individual work order folders.
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Avoidance zone settings
With the software you can use avoidance zones. To create the avoidance zone, use the Business 
Center software - HCE. In a CAD file, create closed polygons around the different zones and mark 
them as avoidance zones. Place the CAD file called *.avoid.dxf in the SCS900 Site folder. 

As you approach an avoidance zone, the software warns you audibly and visually:

 l Yellow = Approaching the avoidance zone

 l Red = Inside the avoidance zone

To adjust the tolerance for the avoidance zone, select the Trimble icon menu / Settings / Avoidance 
Zone Settings.
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Creating and opening a work order in the field
From the Home menu, tap Site. After starting the software, you can select  a site and work order to 
start with:

For each of these options, you can either decide to open an existing site, design, and work order, or 
create a new one. The New option opens a screen with a number of fields where you can define the 
settings and add data files from a USB drive or from data already stored on the controller.

CAUTION – Before taking a measurement or associating a design with the site, ensure that the distance units are 
correctly set. All files that relate to a single site must be stored and operated with the same units. Once a 
measurement is taken, or a design is selected, you cannot change the units.

When creating a site on the controller, you can import or measure a site calibration or use a 
published coordinate system from the coordinate system manager. After you select the Select 
coordinate system option and tap Select coordinate system, the software will list all supported 
coordinate systems.
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If you need to use a geoid, you must export it from the Business Center - HCE software the first time, 
and store it in the Trimble GeoData folder.

A work order can include instructions for the person in the field explaining what tasks to carry out. 
Work order instructions entered in the office will appear in this screen when selecting the work 
order. When creating a work order in the field, instructions can be entered in the instruction box 
too:

Work orders should have a meaningful name to make it easy to identify them when multiple work 
orders are created for a particular project.
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Connected Community service
The Connected Community service includes the following services:

 l Wireless Data Synchronization to synchronize SCS900 data with the data stored in the 
Connected Community website.

 l IBSS (Internet Base Station Service) web service to receive base station corrections from the 
local base station through the Internet.

 l Remote Assistant to remotely connect to a field controller for Trimble Support purposes. 

All these service are tied to the device ID that you need to purchase for the controller with a 
monthly TCC subscription.

Registering the controller
To use the controller with the Connected Community services, you must register the controller in 
the Connected Community Device Manager of the user organization. 

 1. In the SCS900 software, select Import / Export.

 2. Tap Community Settings .

 3. Enter the credentials and then tap Accept.

You only need to do this once. You can also enter a work group for Wireless Data Sync to group 
multiple controllers of a company in a certain structure.
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Wireless Data Sync
The Wireless Data Sync option enables your SCS900 data to be synchronized with your data stored 
in the Connected Community website, which eliminates the requirement to move data to and from 
the field, but uploads design updates and work order results to the Connected Community website.

To manage the synchronization process, the following set of rules controls the dataflow to, and 
from, the Connected Community website.

File Type Currently 
on the 
Connected 
Community

Currently 
on the 
controller

Action

Work Order Download to the controller

Upload to the Trimble Connected Community service

Upload to the Trimble Connected Community service 
if the file size is different

Design Data Download to the controller

Upload to the Trimble Connected Community service

Download if the file size is different

Site Download to the controller

Upload to the Trimble Connected Community service

Download if file size is different

Calibration File
(*.DC & *.CAL)

Download to the controller

Upload to the Trimble Connected Community service

Ask when the file size is different

Field Control Point File
(*.field.csv)

Download to the controller

Upload to the Trimble Connected Service

Ask when the file size is different

Office Control Point 
File
(*.office.sv)

Download to the controller

Upload to the Trimble Connected Community service

Download if the file size is different

FXL File Download to the controller

Upload to the Trimble Connected Community service

Ask when the file size is different
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File Type Currently 
on the 
Connected 
Community

Currently 
on the 
controller

Action

Report.txt,
Tasklog.txt 

Download to the controller

Upload to the Trimble Connected Community service

Upload if the file size is different

Site.ini, Site.xml,
Site.xml.schema 

Download to the controller

Upload to the Trimble Connected Community service

Do nothing

Trimble GeoData Download to the controller

Upload to the Trimble Connected Community service

Download if the file size is different

With every synchronization, the software stores the designs and work order names that have been 
synchronized in a history. If designs or work orders are deleted from the Trimble Connected 
Community service since the last synchronization, the SCS900 software will also delete the files from 
the controller and then proceed with normal synchronization rules from above thereafter. Deleted 
work order data is stored in an Archive folder on the server.

The software facilitates two Control Point files in the site folder; a Field Control Point file where all 
control points measured in the field are stored; and, one or more Office Control Point files. The 
following file naming conventions must be used:

 l Office Control Point File:  [filename].office.csv

 l Field Control Point File:   [filename].field.csv

The Office Control Point file cannot be edited in the field, however the Field Control Point file can. 
Using the Business Center – HCE software, the data manager can take the control points from the 
Field Control Point file of one controller, move it to the Office Control Point file and then push the 
new Office Control Point file out to other controllers.

When a site is opened for the first time with version 3.4 or later of the SCS900 software, and the 
software cannot find a Field Control Point file, the software converts the name of the existing 
Control Point file and applies the naming convention for the Field Control Point file. From that point 
forward, the software will ignore all CSV files in the Site folder that are not tagged office or field. The 
synchronization will only include Control Point files that are marked as Office or Field Control Point 
files. The synchronization rules for the Office and Field Control Point file from above apply.

Remote Assistant
The Trimble Remote Assistant is a service that establishes a remote connection to the field controller 
for Trimble Support purposes. The controller must be registered in the Connected Community 
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Device Manager of the user organization. To do this, see Registering the controller, page 45.

To start the Remote Assistant service:

 1. From the Trimble icon menu, tap System Info.

 2. Tap Start Trimble Remote Assistant to establish the connection to the office. A small icon in 
the status bar shows that the connection is successful.

Note – Trimble Remote Assistant is available only on Trimble TSC3 controllers.
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In this chapter: 

 n Displaying cut/fill

 n Checking a grade/elevation

 n Checking material thickness

 n Measuring a surface or a feature

The SCS900 software is a site measurement tool 
that enables you to monitor earthworks and 
surface finishing operations. It enables 
construction contractors to measure material 
volumes, monitor grades and laid material 
thicknesses, and to perform site measurement 
tasks such as points, lines, and surfaces.

 

Displaying cut/fill
If the software is not in Measure mode, tap the 
Home button and then tap Measure. Walk 
anywhere on the design surface and view the 
current cut/fill on the Info bars, page 35. The 
lightbar on the left side of the screen indicates 
whether the surface is in cut, fill, or on grade.
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Checking a grade/elevation
Measure a surface point at a location where you want to view and record the difference in elevation 
between the design surface and the actual ground.

 1. If not in Measure mode, tap the Home button and then tap Measure.

 2. Tap Measure to record a surface point and the cut/fill value at that location.

The software draws a box of the size that you specify around every recorded point so you can easily 
view where data is missing.

As you move around, the values in the boxes at the top of the screen update.

Once a point is recorded, a colored box appears around it, showing it as in tolerance (green), cut 
required (red), or fill required (blue).

To change the cut/fill tolerances:

 1. Tap the Trimble icon menu and then tap Settings / Measure Settings.

 2. Enter the required tolerances and then tap Accept.

Tip – If a gray box appears, tap the zoom window icon and draw a box around the area of the gray box. Gray 
boxes appear when the map is zoomed out too far to see the colored boxes at the specified resolution.

If no boxes appear, tap   from the toolbar on the right. Ensure that the Coverage Grid check 
box and the Cut/Fill option are selected.  You can also change the grid size.
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Checking material thickness
The typical procedure for checking a material thickness is:

 1. Measure the existing surface before laying the material.

 2. Save the measured surface as a design.

 3. Create a new work order and then select the saved design as the design.

 4. Lay the new material.

 5. Check the material thickness.

If the current material thickness is too thin, a blue square appears to show that more “fill” material 
is required.  If the current material thickness is too thick, a red square appears to show that material 
is required to be “cut” away. If the current material thickness is within a specified tolerance, a green 
square appears to show that no action is required.

 1. If not in Measure mode, tap the Home button and then tap Measure.

 2. Tap the Trimble icon menu and then select Settings / Measure Settings.

 3. Enter the required thickness as a surface offset (you can change tolerances here too).

 4. Tap Measure to record a point and the cut/fill value at that location.

As you move around, the values in the boxes at the top of the screen update; the thickness of the 
material is shown in the Thickness box.

Once a point is recorded, a colored box appears around it showing whether it is within the tolerance 
range or whether more or less material is required.

Tip – If a gray box appears, tap the zoom window icon and draw a box around the area of the gray box. Gray 
boxes appear when the map is zoomed out too far to see the colored boxes at the specified resolution.

If no boxes appear, tap    from the toolbar on the right. Ensure that the Coverage Grid check 
box and the Cut/Fill option are selected.  You can also change the grid size.

Measuring a surface or a feature
 1. If the software is not in Measure mode, tap the Home menu and then tap Measure.
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 2. Tap the icon highlighted above to choose between point and line and surface and non-surface 
feature to be measured:

 3. You can also enter a point name (will be automatically incremented) and point code. The status 
bar icon changes depending on what kind of point or line you choose to measure:

Icon  Definition

Surface Point Elevation is used to create a terrain 
model.

Feature Point Elevation is not used to create a 
terrain model.

Feature Line or Area Elevation is not used to create 
terrain model.

Breakline, Volume Boundary, or Outer 
Boundary 

Elevation is used to create a terrain 
model.

To create an outer boundary, volume boundary, or surface points to add to an existing  line, select 
the correct line type.  Once a surface is measured, you can save the surface as a design and then 
perform a material thickness check.

To save the surface as a design:

 1. From the Home menu, tap Import/Export.

 2. Tap Surface as Design.
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Measuring with feature codes – Advanced Measurement module 
required
The software can use feature codes to record data on site. Create and customize the feature code 
library using the Feature Definition Manager of the Business Center - HCE software.

The feature code defines if a point, line, or breakline is measured. The following classes of feature 
codes are available:

Feature code class Definition

Point feature, but no surface feature.

Line feature, but no surface feature.

Point feature and surface point.

Line feature and breakline.

Feature contains optional or compulsory attributes.

The currently selected feature code and its class can be identified in the status bar. To select and 

manage feature codes in the field, tap .
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Select this option… to…

① filter by group or category.
② toggle to the Grid view.
③ drag code to the Quick Select list.
④ select from the Quick Select list.
⑤ select a feature code. 

To select a feature code, either tap on one of the buttons in the Quick Select list or select a feature 
code from the Grid view.  The Grid view enables you to measure data without seeing the map.  
Instead you have up to 34 codes to choose from with a  single tap.

Both the Grid view and the Quick Select list selection enable you access feature codes quicker by 
filtering feature codes by group and category. Groups and categories must be defined in the Feature 
Definition Manager in the office.

A category is a class of related feature codes, for example, vegetation. For certain measurements or 
tasks, you might want to group feature codes from different categories into a group for faster 
access.

With each feature code, different attributes can be stored, which enables you to describe a recorded 
point or line with more information. Attributes need to be set up in the Feature Definition Manager 
and cannot be changed or created in the field.

Different properties can be applied to each attribute, for example, if it is optional or compulsory to 
fill out this attribute, which values are required for this attribute, the permitted length of the text 
string that you can enter, or available items in a drop-down list.

Photos
Photos can be attached as an attribute using the internal camera of your site controller.

The pictures are geotagged using the position of the internal GPS of the device or the position of an 
external SPS GPS receiver, if available. Photo attributes are set up in the Feature Definition Manager.
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In this chapter: 

 n Compute Volumes

 n Review & Edit Data

 n Create Points/Arcs

 n Enter/Edit Stakeout Points

When collecting data in the field, it is useful to be 
able to review and edit your data. This section 
covers reviewing and editing any surface data you 
have measured, calculate new points and lines in 
the field, and calculate the volume from measured 
data.
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Compute Volumes
Use the Compute Volume option to calculate a volume from the data you have measured. Three 
types of volumes can be calculated:

 l To a design surface

 l To an entered elevation

 l To a surface created by the volume boundary (stockpile/excavation volume)

From the Review & Edit Data menu,  (see page 57), tap Contour Measured Surface  to view 
contours based on the surface you have measured. This is a useful tool to check for any major 
errors. The contours highlight any elevation errors in the data.

 1. In the Elv. Interval field, enter a contour interval  and then press Enter.

 2. Tap the Compute Volume icon . 

 3. Tap on the boundary of the area for which you want to calculate the volume and then tap OK.

 4. Select the type of volume to compute:

 a. The volume from the surface you have measured to the design surface.

 b. The volume to a user-defined elevation.

 c. The volume of a stockpile/depression.

 5. The following screen shows the result of the volume calculation. A depression or shrinkage 
factor can be entered to accommodate for material expansion or shrinkage.
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The results of the calculation are stored in the site report using the name of the volume 
boundary.

Review & Edit Data
Use this feature to delete points you may have incorrectly measured. You can also use this feature 
to calculate volumes of any surfaces that you have measured. 

It also enables you to display contours of the surface, which serves as a quick check that you have 
correctly collected data.

 

From the COGO menu, tap Review & Edit Data .

The Review and Edit Surface screen has a list of icons on the left side, which represents all the 
available functions:

Icon Description

Compute Volumes

Create Line/Boundary

Delete Point/Line
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Icon Description

Generate Measured Contours

Delete Measured Points and Lines

Compute Distance

Compute Total Distance

Compute Area

Compute Down and Out from Line

Compute Angle

Icon Help

To  undo an action, tap .

Create Points/Arcs
Use the Create Points/Arcs option to create design data in the field. You can create new points 
relative to other points and lines in the work order or in the current loaded design. 

From the COGO menu, tap Create Points/Arcs .
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A variety of functions are available in the bar on the left:

Icon Description

Create a radius point for an arc.

Create offset points from a line.

Create an offset point at a certain station.

Create a mid-point of a line or arc.

Subdivide a line or arc in segments.

Create a point at a distance and bearing.

Enter the coordinates of a stakeout point.

Create points at the end of a line or arc.

Free Point Pick.

Toggle display bar.

Create a point at the intersection of a line.

Tells you In and Out of a point from the line.

Delete points and lines.

Create an arc from three points or two points and radius.
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Icon Description

Create a new line from two points.

Icon help.

The points can be stored as stakeout points or as measured points. A surface can be generated from 
measured points, which you can export to the GCS900 or AccuGrade grade control systems for 
machine guidance.
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Create/Edit Roads
Use the Create Points/Arcs option to create design data in the field. You can create new points 
relative to other points and lines in the work order or in the current loaded design. 

From the COGO menu, tap Create/Edit Roads .

A variety of functions is available in the bar on the left:

Icon Description

Create/edit a roadway alignment.

Create and position road templates.

Create stakeout points at a certain station and offset from the road 
alignment.

Create stakeout points at a certain station and with a deflection angle from 
the road alignment.

Change the Key In road entry method.

The points can be stored as stakeout points or as measured points. A surface can be generated from 
measured points, which you can export to the GCS900 or AccuGrade grade control systems for 
machine guidance.

Creating an alignment

Tap the Create/Edit Roadway alignment icon . A tabular entry screen appears to enter the 
geometry for the horizontal and optional vertical alignment.
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To convert a polyline of the current loaded design or work order in an alignment, tap Map.

If roads already exist in the current design that were created in the SCS900 software, you are 
prompted to choose to edit an existing road or create a new one:

Complete the numeric boxes to define it.

The following table shows the record types that the SCS900 software supports and the data that 
you must enter for each type. Depending on the Key In Road settings, the alignment can be entered 
via segments or via coordinates for the points of intersections. The POB is the Point Of Beginning, 
which is always the first record for a horizontal alignment and contains the start station and 
coordinates. The azimuth is always automatically computed and appears in the table as Tangent. If 
you tap on this field, the software displays the actual calculated azimuth. If required, you can 
overwrite it with your own value. You can also enter the azimuth as a bearing (that is, S 90 W = 
azimuth of 270°).

Record type Col1 Col2 Col3 Col4

POB (Point of 
Beginning)

Station Northing Easting  
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Record type Col1 Col2 Col3 Col4

Line Azimuth Length   
Spiral In Azimuth Direction Radius Length
Arc Azimuth Direction Radius Length
Spiral Out Azimuth Direction Radius Length
Combining Spiral Azimuth Length   

The end station value appears as you enter the road details. Tap Map to see the plan view of the 
alignment you are creating:

 

Creating a vertical alignment
Tap Next. The Create Vertical Alignment screen appears:

Complete the numeric boxes to define it.

This table shows the record types that the SCS900 software supports and the data that you must 
enter for each type. The POB is the Point Of Beginning, which is always the first record for a vertical 
alignment and contains the start station and elevation.
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Record type Col1 Col2 Col3

POB (Point of Beginning)Station Elevation  
Arc VPI Station Elevation Radius
Vertical VPI Station Elevation Length
Grade Break Station Elevation  

The final station value must be the same as the end station displayed in the previous Horizontal 
Alignment entry screen. Tap Map to see the profile view of the alignment you are creating:

 

If there is no current design, you are also prompted to create a new SCS900 design.

The main create road screen reappears showing you the plan view of the alignment you have just 
created:
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Positioning and creating templates
Tap the position and create road template icon. The following screen appears:

Pick the required station for the template. The following screen appears which allows entering the 
template.

Button Description

Code for the feature node you are about to enter.

Horizontal distance to the last feature node which was entered.

Vertical distance to the last feature node which was entered.

Create Feature Node with the entered values.

Slope values for the Cut tie.

Slope values for the Fill tie.

Delete feature node.

Trimble SCS900 Site Controller Software User Guide 65



7   Volume and COGO

Button Description

Copy the right side to the left side.

Copy the left side to the right side.

Import a previously entered template.

Export a previously entered template.

When you first enter this screen, you will be asked if the values apply for the right side or the left 
side of the road; the values are applied from the centerline.

Tap Insert to see the edge of pavement on the right side of the road on the cross section.
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Copy the right side of the road over to the left side by tapping the copy template button. When the 
template is complete, tap Accept. Enter a name for the template and whether you want to store the 
template in a library that can be accessed from any site on the controller.

Using templates means you can easily recall them by tapping the import template button. Select a 
template from the list. The whole definition appears in the cross section view.

You can view the templates either in plan view or cross section view at any station you want. You 
can also view the templates at stations between definitions. The SCS900 software transitions 
between the templates.

Creating stakeout points
Two COGO functions are available:

 l Create stakeout points at an offset from the alignment. This function can be used for any road, 
not just ones created in the SCS900 software.

 l Create stakeout points at an offset from the alignment at a deflection angle. For example, this 
can be useful where a drain crosses a road. This feature can be used for any road, not just ones 
created using the SCS900 software.

Enter/Edit Stakeout Points
Use this feature to retrieve a list of all stakeout points in the currently loaded design. Tap Edit, Add, 
or Find to make changes or to completely delete the point.
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In this chapter: 

 n Points

 n Stakeout Settings

 n Lines

 n Slope staking

 n Reference Line

 n Surfaces

 n Planes

 n Roads

The SCS900 software enables stakeout points, 
lines, surfaces and roads stored in a design. You 
can access the Stakeout menu either through the 
Home menu, or tap and hold on items in the 
Measurement screen.
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Points
Before you can stake out points, the points must be part of the currently loaded design. There are a 
number of ways to get points into a design:

 l Enter the coordinates of the point in the SCS900 software using the Enter/Edit Stakeout Points 
functions.

 l Use the Create Stakeout Points COGO functions.

 1. From the Measurement screen, tap the Home button and then tap Stake.

 2. Select a point using the list at the top right of the screen and then select a stakeout point in the 
Points tab. Alternatively, select the point directly from the map. If there is more than one 
object available in this area, a list of different objects appears that you can select from.

The following symbols distinguish the different stakeout items:

Icon Description

Points

Lines

Roads

Surfaces

 3. If you need to calculate a stakeout point from design data, tap Home and use the functions in 
the COGO menu.

 4. Multiple stake methods (point, side slope, and catch point) are available. For information 
about slope staking, see page 73.

 5. Use the values in the info bar (for example, GO) to navigate to the point. A small green arrow 
between your current position and the stakeout point provides you with guidance. In addition, 
a large arrow on the top right of the screen turns in the correct walking direction after the 
software recognizes in which direction you are currently moving. When using a map rotation in 
travel direction or following a selected alignment, an additional North Arrow on the top left 
indicates North so that the values in the info bar can be used to navigate to the point.

 6. When you are close to the stakeout point, the software switches into the Fine Stake mode. 
Additional guidance arrows appear on the top right corner of the map to indicate the remaining 
distance in each direction. The screen is orientated to the last moving direction before the Fine 
Stake mode was selected.

 7. Once you are within tolerance, the dot in the circle of the stake guidance turns yellow.  After 
tapping Stake, a stakeout report for this point appears. The software remembers which tab of 
the stakeout report was last viewed and opens the same tab after staking the next point.

 8. Select the Edit stakeout name check box to store the staked point using a different point name 
and point code.
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In another tab, a graphical diagram shows how to put an elevation mark on the stake. The 
software does all the calculations for you.  The way that the software calculates the elevation 
mark and cut/fill depends on the stakeout settings in the Trimble icon menu

 9. After staking out the point has been completed, the software returns to the Stakeout Selection 
screen. If during the stakeout process a different point is selected, tap the Trimble icon menu  
and then tap Change Stake Object .

 10. To change the stakeout elevation to a different value, tap the Trimble icon menu and then tap 
Stakeout Elevation .

Stakeout Settings
To access these settings, from the main menu, select the Trimble icon menu in Stakeout mode and 
tap Stakeout Settings. The software supports three elevation reference methods used to mark cut 
depths or fill heights on a grade stake or location/grade stake:

 l Measuring the cut/fill reference mark from the ground surface

 l Measuring the cut/fill reference mark from the top of the stake

 l Cut/fill reference from the measured point

These methods help you to establish a cut/fill reference mark on the stake at a specified cut/fill 
measurement interval, such as at one-foot increments. If you choose to place a cut/fill reference 
mark on the grade stake, a Stake Marking report helps you establish the position of the reference 
mark on the stake and helps you correctly label it.

Typically, you will use one of the above methods consistently. Usually, you use only one method. 
When you first receive the software, switch to the correct setting. The software then uses that 
setting for all stakeout operations. When you tap Stake during a stakeout operation, the software 
converts the measured elevation, design elevation, and computed cut depth or fill height into 
information that you can then write on the stake. It also informs you where to mark the stake based 
on the settings that you enter in this dialog:
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The stakeout tolerance is also entered in this dialog. 

Note – You can only stake a point or location when you get close to the point to stake, at which 
time the Stake button appears on the map view.

Measured Point
This method enables you to label a grade stake with the required cut depth or fill height as 
measured from the measured point, which can be either the top of stake or the current ground 
surface. If you choose to mark the stake with the cut depth or fill height as referenced to the 
measured point, the software simply informs you of the cut or fill measurement. In this case, you 
can mark that measurement on the stake, using your normal convention to indicate from where the 
measurement is referenced.

Ground Surface
With this method, the software guides you to the horizontal location of the stakeout point. The 
software generates a Stake Marking report that shows the distance from the ground up to where 
you must mark the stake. It also shows the value of cut or fill to mark on the stake.

Top of stake
With this method, the software guides you to the horizontal location of the stakeout point. You 
then hammer the stake into the ground and measure the top of the stake. You can change the 
antenna height for this measurement in case you want to take the receiver off the pole and place it 
directly on the stake. The software shows the distance from the top of the stake down to where you 
must mark the stake. It also shows the value of cut or fill to mark on the stake.

Trimble SCS900 Site Controller Software User Guide 71



8   Stakeout Workflow

Lines
The lines you want to stake out must be part of a design map in the currently loaded design. There 
are multiple ways to get lines into a design:

 l From a DXF foreground map with lines created in the Business Center - HCE Software.

 l By creating lines from points using the COGO functions

 1. From the Measurement screen, tap the Home button and then tap Stake.

 2. Select a line using the list at the top right of the screen and then select a stakeout line in the 
Line tab. Alternatively, select a line directly from the map. If there is more than one object 
available in this area, a list of different objects appear where you can specify your selection. 
When using the Business Center - HCE software, names can be assigned to lines, which 
improves  the orientation.

You can also create a new line from points in your loaded design or work order by tapping the 
New line icon in the top right corner of the screen:

 3. If necessary, before confirming the selection, change the line direction using the button on the 
top right of the screen.

 4. Different stake methods (side slope and catch point) are available. See Slope staking, page 73.

 5. Enter the station to be staked out or tap on the line where you want to stake it and then tap 
OK.

 6. The map view then guides you to the point. To help you find the point, the guide arrow needs 
to point up the screen to show that you are traveling directly toward the point. You can turn 
the guide arrow off and on. The information bars at the top of the screen can be customized 
using the Customize Info Bars option in the Trimble icon menu.  The display shows the design 
elevation for the point, the amount of cut or fill required to get to that elevation, and how far 
and in what direction you need to travel to get to the point.
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 7. The default map view has the direction north pointing up. You can change this so that the 
guide arrow is pointing in the direction you are walking by changing the map rotation in the 
Map Options dialog. A cut/fill lightbar on the left graphically shows cut and fill.

 8. When you are close to the selected line point, the software switches into the Fine Stake mode. 
Additional guidance arrows appear on the top right corner of the map to indicate the remaining 
distance in each direction. The screen is orientated to the last moving direction before the Fine 
Stake mode was selected. When you are within tolerance, the dot in the circle of the stake 
guidance turns yellow.

After tapping Stake, a stakeout report appears. The software creates a Stake Marker report. A 
graphical diagram shows how to put an elevation mark on the stake. The software does all the 
calculations for you. The way the software calculates the elevation mark and cut/fill depends on 
the stakeout settings in the Trimble icon menu. The software remembers which tab of the 
stakeout report was last viewed and opens the same tab after staking the next point.

 9. 

Instead of staking a certain station it is also possible to stake a line at random stations using the 
buttons on the bottom right in the status bar:

Tap to

stake at fixed intervals starting at a certain station

stake at random intervals somewhere along the line

Enter a horizontal and vertical offset for the stakeout line. The line elevation can be defined 
using different methods and the start station, station interval (increment distance), and 
whether or not to automatically advance to the next station can also be determined. If a 
horizontal offset is applied and the Generate tangent/corner points check box is selected, 
three stakeout points are created at each corner to help you stake out the lines. Access these 
settings from the Trimble Icon menu under Settings / Line settings.

Slope staking
For both stakeout point and stakeout lines, side slope and catch point stakeout modes are available 
that enable staking out the slope or the catch point between this slope and the existing ground. This 
function can be applied to any earthwork operation that involves a tie to the current ground 
surface. Examples include staking earthworks for pad placement, earth dams, site drainage, ponds, 
lagoons, embankments, and keyways.

The tie-slope can be projected from a 3D point using a bearing or from a 3D Line. After defining 
either one of those, the stakeout process is very much alike. Use the Define Side Slope dialog to 
select the direction of the slope and whether you define a cut and/or fill side slope to the left or right 
of the reference line. To select what the slope designation is to be based on, alter the selection in the 
Slope direction field.
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The software computes the elevation of the reference line at that point, and projects the designated 
cut and/or fill side slope magnitudes from that reference point, through your position, along a line 
referred to as the slope indicator. The slope indicator line is shown in the map view, extending from 
the reference line to the currently predicted catch point location. In predicting the location of the 
catch point, if you have defined both cut and fill slope magnitudes, the software determines 
whether the cut slope or fill slope is applicable at the reference point.

When staking building pad side slopes, the building pad has both internal and external right-angled 
corners. If you are staking external corner points, then the software automatically calculates the 
side slope as projected radially from the corner point. At an internal corner, the software calculates 
the catch point at a bisectional angle.

The Catch point option enables you to stake out points where the side slope intersects the ground 
surface as it is found to exist. As you stake catch points at fixed intervals, you should adapt to the 
existing terrain and be aware of the effect that it may have on the location of the daylight line. You 
can freely switch between the Stake at fixed intervals mode and Stake at randomly chosen interval 
modes.

The Line option enables you to stake out the side slope’s reference line. The software guides you to 
the line at the nearest point to where you currently are, or to a specific station. The Side Slope 
option enables you to place a grade stake at any required location on the side slope between the 
reference line and the catch point. You can toggle between the different stakeout methods using 
the button at the right of the status bar. Tap on the icon on the right of the status bar:

Icon Description

Stake catch point

Stake side slope

Stake line
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Reference Line
While staking out different objects like a point, line, surface or road another line or alignment can be 
selected and referenced. To select a reference line or alignment, define the primary stakeout object 
and then tap Reference Line in the Trimble icon menu. Select the reference Line from the map.

When a line is used as a reference line, an optional horizontal offset and a line start station can be 
applied.

The station and offset to this reference line can be displayed in the info bar as reference station (R. 
Sta) and reference offset (R. Off) while staking the actual object.

Surfaces
Use the Stake Surface feature to put grade stakes over a design surface indicating the cut/fill to it. 
The surface you want to stake out must be part of the currently loaded design. There are multiple 
ways to get a surface into a design:

 l From a TTM surface file (this can be created in the Business Center - HCE software).

 l By creating a surface design from an existing SCS900 work order using the Import/Export 
feature.

 1. From the Measurement screen, tap Home and then tap Stake.

 2. Select the surface using the list on the top right of the screen and then in the Surface tab select 
a stakeout surface.

 3. Use the values in the display bar to indicate the current cut/fill.

 4. After tapping Stake, the software creates a Stake marker report. A graphical diagram shows 
how to put an elevation mark on the stake. The method that the software uses to calculate the 
elevation mark and cut/fill depends on the Stakeout Settings in the Trimble icon menu.
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Planes
Use the Stake Plane feature to define a plane very similar to how a grade laser works and then use 
GPS or a total station to get an indication of the resulting cut/fill between the current position and 
the plan. There are three options to create a plane to stakeout:

 l Level Plane – Choose an elevation to define the level plane.

 l Sloping Plane – Choose an origin point and elevation, a main slope, and an optional cross 
slope. 

 l Three Point Plane – Create a plane from three points.

 1. From the Home menu, tap Stake.

 2. On the top right corner, tap the Define Plane icon . The Define Plane dialog appears:

 3. Select and configure the plane you want to stake.

 4. Use the values in the display bar to show the current cut/fill.

 5. To record a point and view the stakeout report, tap Stake.

Roads
The road or alignment that you want to stake out must be part of the currently loaded design. 
There are multiple ways to get a road into a design:

 l From a road corridor created in the Business Center – HCE software and exported through the 
Field Data menu.

 l Convert LandXML files with the SCS Data Manager.

 l Export a road from the Terramodel® software.

If you have the Road module installed and a Road design loaded, you can select a road/alignment 
from the map or from the list in the Stake menu and select one of the three road staking methods 
that are available:
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 l Roadway feature staking(see page 78)

 l Catch point staking(see page 83)

 l Location on Surface(see page 86)

If no Roading option is installed on the controller, a warning appears.

The grade stake marking preferences in the Stakeout Settings also apply to staking roadways. 
Staking methods for catch point staking can be set in the Trimble icon menu under Settings / Catch 
Point Marking while in the Catch Point staking mode.

Roads
The road or alignment that you want to stake out must be part of a design map in the currently 
loaded design. There are multiple ways to get a road into a design:

 l From a road corridor created in the Business Center – HCE software and exported through the 
Field Data menu.

 l Converting LandXML files with the SCS Data Manager.

 l Exporting a road from the Terramodel software.

If you have the Road module installed and a Road design loaded, you can select a road/alignment 
from the map or from the list in the Stake menu and select one of the three road staking methods 
that are available:

 l Feature

 l Catch point

 l Location

If no Roading option is installed on the controller, a warning appears.

The grade stake marking preferences in the Stakeout Settings dialog also apply to staking roadways. 
Staking methods for catch point staking can be determined in the Trimble icon menu under 
Roadway feature staking.

 1. From the Measurement screen, tap the Home button and then tap Stake.

 2. Select a road or alignment using the list at the top right and then selecting an alignment in the 
Road tab. Alternatively, select an alignment directly from the map. If there is more than one 
object available in this area, a list of different objects appear where you can specify the 
selection.

 3. Entered a station or select one from the map at which to stake out the road feature. A cross 
section of the roadway appears. It notes the location of each roadway feature as a node on 
that cross section. The Select Roadway Feature screen appears.

 4. Select the roadway feature node that represents the roadway feature that you want to stake 
out. To select a node, do one of the following:
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 a. Select from a node list (tap in the top right corner).

 b. Tap the required node.

If the node is on the finished grade model, the name of the node would be SHLD, for example. If 
the node being selected is on the subgrade adjusted surface, it would be named SHLD-0.250; 
meaning it is the SHLD node, but it has a -0.250 m. To enter a subgrade, access  Road Settings 
through the Trimble icon menu while in the Road Stakeout mode.

If you are navigating up station, the normal cross-section view is displayed left to right as 
expected. If however, you are navigating down station, then the cross section would normally 
be back to front. To reverse the view of the section, change the view setting to up station or 
down station entered by accessing Road Settings through the Trimble icon menu while in the 
Road Stakeout mode.

 5. Let the software guide you to the point to be staked on the selected feature using the values in 
the info bar. To help you find the point, the guide arrow needs to point up the screen to show 
that you are traveling directly toward the point. You can turn the guide arrow off and on. The 
information bars at the top of the screen can be customized using the customize info bar 
option in the Trimble icon menu.  The info bar shows by default the design elevation for the 
point, the amount of cut or fill required to get to that elevation, and how far and in what 
direction you need to travel to get to the point. You can scroll through the different values 
using the black arrows on either side of the info bar. The default map view has the direction 
north pointing up. You can change this so that the direction you are walking is pointing at you 
by changing the map rotation in map options. A cut/fill lightbar on the left graphically shows 
cut and fill.

 6. When you are close to the required line point, the software will switch to the Fine Stake mode. 
The design map will be overlaid by guidance arrows to indicate the distance in each direction. 
The screen is orientated according to the map rotation settings in the map options function.

Once you are within tolerance, the opaque overlay with the guidance arrows will become solid. 
After tapping Stake a stakeout report appears. A graphical diagram indicates how to put an 
elevation mark on the stake.  The method that the software uses to calculate the elevation 
mark and cut/fill depends on the Stakeout Settings in the Trimble icon menu.

 7. Instead of staking a certain station, it is also possible to stake an alignment at random stations 
using these buttons on the bottom right in the status bar.

Roadway feature staking
 1. From the Measurement screen, tap the Home button and then tap Stake.

 2. Select a road or alignment using the list at the top right of the screen and then select an 
alignment in the Road tab. Alternatively, select an alignment directly from the map. If there is 
more than one object available in this area, a list of different objects appear where you can 
specify a selection.
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 3. Enter a station or select one from the map at which to stake out the road feature. A cross 
section of the roadway appears. It notes the location of each roadway feature as a node on 
that cross section. The Select Roadway Feature screen appears.

 4. Select the roadway feature node that represents the roadway feature that you want to stake 
out. To select a node, do one of the following:

 l  l Select from a node list (tap in the top right corner).

 l Tap the required node.

If the node is on the finished grade model, the name of the node would be SHLD, for example. If 
the node being selected is on the subgrade adjusted surface, it would be named SHLD-0.250; 
meaning it is the SHLD node, but it has a -0.250 m. A subgrade can be entered by accessing  
Road Settings through the Trimble icon menu while in Road Stakeout mode.

If you are navigating up station, the normal cross section view is displayed left to right as 
expected. If however, you are navigating down station, then the cross section would normally 
be back to front. To reverse the view of the section, make sure Road Stakeout mode is selected, 
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then select the Trimble icon menu / Road Settings, and change the view setting to up station or 
down station.

 5. Let the software guide you to the point to be staked on the selected feature using the values in 
the info bar. To help you find the point, the guide arrow needs to point up the screen to show 
that you are traveling directly toward the point. You can turn the guide arrow off and on. The 
information bars at the top of the screen can be customized using the Customize Info Bars 
option in the Trimble icon menu.  By default, the info bar shows the design elevation for the 
point, the amount of cut or fill required to get to that elevation, and how far and in what 
direction you need to travel to get to the point. You can scroll through the different values 
using the black arrows on either side of the info bar. The default map view has the direction 
north pointing up. To change this so that the direction you are walking is pointing at you, 
change the map rotation in Map Options. A cut/fill lightbar on the left graphically shows cut 
and fill.

 6. When you are close to the selected node, the software switches into the Fine Stake mode. 
Additional guidance arrows appear on the top right corner of the map to indicate the remaining 
distance in each direction. The screen is orientated to the last moving direction before the Fine 
Stake mode was selected.

 7. After tapping Stake, a stakeout report appears. The software creates a Stake Marker report.  A 
graphical diagram shows how to put an elevation mark on the stake. The software does all the 
calculations for you.  The way that the software calculates the elevation mark and cut/fill 
depends on the stakeout settings in the Trimble icon menu. The software remembers which 
tab of the stakeout report was last viewed and opens the same tab after staking the next point.

Instead of staking a certain station, you can also stake an alignment at random stations using 
these buttons on the bottom right of the status bar:

Tap… to…

stake at fixed intervals starting at a certain station.

stake at random intervals somewhere along the line.

 8. Set the Auto advance option field to one of the following options using the Road Settings 
dialog in the Trimble icon menu:

To move to the… select…

next station automatically advance to the next station.
previous station automatically advance to the previous station.

Do not automatically advance. This option maintains the current station 
between points, and enables you to increase or decrease the station when 
you are ready.

No (not move a 
station)

Depending on the settings for Station Interval, SCS900 will or will not 
advance to the next station.
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Simple feature offset
When staking a feature, an offset is usually applied. The software is extremely flexible in the way that 
it enables you to specify an offset.

After selecting roadway feature node (Step 4 above) tap the button with the stake and the two red 
arrows on the top right of the screen. The Define Feature Offset screen appears. The second line 
enables you to specify the fixed horizontal offset or select a random horizontal offset. When 
specifying a fixed offset, a red line and a circle shows you where that offset point is. When specifying 
a random offset, you can stake anywhere along the cross section; the software displays the results 
to the point you are at:

 l The third line enables you to specify the kind of offset you want to use. Define Grade enables 
you to specify a slope for the offset. A grade of 0.000% is horizontal.

 l The red, yellow, green stake on the top right of the screen enables you to apply the offset from 
a different feature node instead of the selected feature node itself.
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Custom feature staking
Instead of staking a roadway feature node, you can define your own custom feature on a cross 
section. One example could be where the subgrade intersects with the tie slope. Follow these steps:

 1. While in the Roadway Feature Selection screen, select the Define Custom Feature option:

 2. Select two feature nodes that will form the subgrade. You can access subgrade adjustments of 
the finished grade from the map view during stakeout (access  the Road menu through the 
Trimble icon menu, and then enter the amount and direction for the offset).

 3. Select a segment (e.g., the tie slope). If required, enter a vertical offset for this segment and if 
you want to apply the offset vertical or perpendicular.

 4. A stake appears where this subgrade intersects the tie slope. Stake out this point as usual. You 
can also specify a horizontal offset for the stake the same way as a normal roadway feature.
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Custom segment staking
Instead of staking a roadway feature node, you can define a custom segment on a cross section. A 
segment is defined as the surface between two roadway feature nodes with an optional offset to 
reflect a subgrade. One example could be where a dam of a road gets build in multiple layers 
without having the complete shape of the finished grade. With this layered lift function, you can do 
the following:

 1. While in the Roadway Feature Selection screen, select the Define Custom Segment option.

 2. Select two feature nodes that will form the subgrade. If required, enter a vertical offset for this 
segment and if you want to apply a vertical or perpendicular offset.

 3. You will get guidance to the first point you have selected. Stake out this point as usual. You can 
also specify a horizontal offset for the stake the same way like a normal roadway feature.  It is 
also possible to enter a random offset and apply the grade of the roadway and then stake this 
layer infinite to the left or to the right and get the cut/fill to this segment.

Catch point staking
Catch point staking from the Road menu operates in an almost identical way to the catch point 
staking associated with the side slope function. The only difference is that the tie slopes are defined 
in the road model itself, and are automatically displayed. In a typical road model, there are at least 
two tie slopes; one for the right and one for the left side of the road. In the case of a divided 
highway, it is common to find four tie slopes, one for the left and right of each of the two traveled 
ways.

 1. From the Measurement screen, tap the Home button and then tap Stake.

 2. Select a road using the list at the top right of the screen and then select an alignment in the 
Road tab. Alternatively, select the road alignment directly from the map. If there is more than 
one object available in this area, a list of different objects will appear where you can specify a 
selection.

 3. Select a stake method catch point.

 4. Enter a station or select one from the map at which to stake out the road feature. A cross 
section of the roadway appears unless no tie slopes were defined for this cross section. You can 
then choose to extend the outer segments of the road and use them as tie slope instead.

 5. Select if you want to stake the tie slope of left or the right side of the road by tapping on the tie 
slope itself or using down arrow on the top right. The selected tie slopes as defined in the road 
model (a cut slope shows in red and a fill slope shows in blue) will be highlighted.
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In the top line of the display, the roadway that the tie slope is associated with is displayed. In 
the example above, there is only one roadway in the selected road job, and that was not 
named—hence Roadway 0 is displayed.

You can redefine the current tie slope while you are staking out. For example, the design may 
specify a 1:3 cut, but when you stake it out you find that the point is outside the site limits, so 
you change the tie slope to a 1:2.5 cut. You can also project the tie slope from any node on the 
cross section.

From the list, select one of the following options:

 l Original cut/full

 l Key-in cut/fill (%) – Enter the new value and then select the node to apply it from

 l Key-in cut/fill (rise:run) – Enter the new value and then select the node to apply it from

 l Key-in cut/fill (run:rise) – Enter the new value and then select the node to apply it from

 l No cut/fill tie – If you select this option, the tie slopes disappear

It is also possible to offset the hinge point by clicking the stake icon on the top right of the 
screen.

 5. Navigate to the correct station using the Ahead/Backward values in the info bar. Then toggle 
the cross section view using the bottom icon in the map control bar and walk toward the tie-
slope you are going to stake.

 6. The software calculates the intersection between this recreated surface and the tie-slope and 
provides you with guidance to this point by extending this surface toward the slope. This point 
is dynamic and changes depending on the way you walk and how the terrain is formed. Use 
inward/outward to find the actual catch point, but also keep an eye on the station.

Once you are in proximity of the point where the tie-slope intersects with the existing ground, 
tap Stake.
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The software creates a Stake Marker report. A graphical diagram shows how to put an elevation 
mark on the stake. Depending on the settings for catch point marking in the Trimble icon 
menu, you will get guidance to one or two more stakes which mark the point. Single Stake, 
Dual Stake, and Batter Rail methods are available. The placement and marking of these stakes 
is completely guided. The software remembers which tab of the stakeout report was last 
viewed and opens the same tab after staking the next point.

 7. Instead of staking a certain station it is also possible to stake a line at random stations using 
these buttons on the bottom right in the status bar:

Tap… to…

stake at fixed intervals starting at a certain station

stake at random intervals somewhere along the line

Trimble SCS900 Site Controller Software User Guide 85



8   Stakeout Workflow

Location on Surface
Location on Surface is a very basic method of staking a road. You can walk over the road surface and 
have the display showing station, offset, and cut/fill to this road surface or navigate to a certain 
station and offset of this road.

 1. From the Measurement screen, tap the Home button and then tap Stake.

 2. Select a road using the list at the top right of the screen and then select an alignment in the 
Road tab. Alternatively, select the road alignment directly from the map. If there is more than 
one object available in this area, a list of different objects will appear where you can specify the 
selection.

 3. Select a stake method location.

 4. Enter a station and offset or select one from the screen. You can also overwrite the design 
elevation at this station.

 5. The map view then guides you to the point. To help you find the point, the guide arrow needs 
to point up the screen to show that you are traveling directly toward the point. You can turn 
the guide arrow off and on. The information bars at the top of the screen can be customized 
using the Configure Info Bars option in the Trimble icon menu.  The display below shows the 
design elevation for the point, the amount of cut or fill required to get to that elevation, and 
how far and in what direction you need to travel to get to the point. The default map view has 
the direction north pointing up. You can change this so that the direction you are walking is 
pointing up by changing the map rotation in map options. A cut/fill light bar on the left 
graphically shows cut and fill.

 6. When you are close to the selected line, the software switches into the Fine Stake mode. 
Additional guidance arrows appear on the top right corner of the map to indicate the remaining 
distance in each direction. The screen is orientated to the last moving direction before the Fine 
Stake mode was selected.

 7. After tapping Stake, a stakeout report appears. The software creates a Stake Marker report. A 
graphical diagram indicates how to put an elevation mark on the stake. The software does all 
the calculations for you. The way the software calculates the elevation mark and cut/fill 
depends on the stakeout settings in the Trimble icon menu. The software remembers which 
tab of the stakeout report was last viewed and opens the same tab after staking the next point.

 8. Instead of staking a certain station, you can stake a line at random stations using these buttons 
on the bottom right of the status bar:

Tap… to…

stake at fixed intervals starting at a certain station.

stake at random intervals somewhere along the line.
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To toggle between Feature, Location, and Catch point staking, tap the right button in the status bar. 
Tap the icon on the top right of the status bar:

Icon Description

Feature

Location on Road Surface

Catch point
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In this chapter: 

 n Setting up the GPS base station

 n Setting up the GPS rover receiver

 n Calibrating the site

 n Measuring a new control point

To perform these measurement tasks, you need 
the SCS900 site controller software running on a 
controller that is either connected to a positioning 
device like a GNSS system or a total station. This 
chapter explains how to set up and use the 
different components of a GNSS RTK system.
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Setting up the GPS base station
For Precision RTK (Real-Time Kinematic) GPS operations, two main components are generally 
required, a base station and a rover receiver. The two components are connected by radio (450 MHz 
or 900 MHz frequency bands) over which RTK corrections are transmitted from the base station to 
the rover receiver. The base station is set up in a fixed location where it tracks the satellites of the 
GPS and, optionally, the GLONASS and QZSS constellations. The rover receiver moves around the 
jobsite on a pole, backpack, vehicle, or earthmoving machine.

The first time that the base station is used on a project, it can be located at a known or unknown 
point. Once the base station is set up, turn it on. The SPS Modular GPS receivers have a front panel 
and keypad that enables the receiver to be initialized and set up without needing a controller; 
however, this guide focuses on using the software to set up the base station.

The base station setup process remembers how the previous setup was made. It automatically 
reconnects the components, selects the appropriate radio channel or network number, and then 
automatically starts to transmit GPS positions. If the base station has never been previously 
established on this site, or if on the last base station setup a cellphone was used to broadcast 
corrections, you must completely set up the base station again using the options in the Select 
Connection Method dialog. In these situations, the Setup radio only option is not available.

When using the SPS Smart GPS antenna or the SPS Modular GPS receivers, which use the 
AutoBase™ technology, once a base station has been established the first time, if nothing is 
changing between setups, you can simply set up the receiver at the base station location and then 
switch it on. Using AutoBase technology, the receiver reloads all appropriate data, makes all 
appropriate connections, and then starts to transmit corrections on the last used radio channel or 
network number. This eliminates the need to use a controller with the software to set up the base 
station each day. If you want the SPS GNSS receivers (SPS Smart GNSS antennas, and the SPS 
Modular GNSS receivers) to operate in AutoBase mode, you must name each base station with a 
different name, otherwise the AutoBase mode appears not to work.

To set up the base station:

 1. From the Home menu, select GPS and then tap Connect.

 2. Set the Mode field to Base and then answer each question to complete the base station setup.
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You only need to do this once; the software remembers your settings and prompts you to use the 
same ones the next time you set up the base station.  You can then change any of the base station 
settings.

Setting up the GPS rover receiver
To set up the rover receiver:

 1. From the Home menu, select GPS and then tap Connect.

 2. Set the Mode option to Rover and then answer each question in turn to complete the rover 
setup.

You only need to do this one; the software remembers your settings and prompts you to use the 
same ones the next time you set up the rover receiver.  You can then change any of the rover 
settings.

Calibrating the site
Global Positioning Systems (GPS) produce positions in latitude, longitude, and height coordinates. 
Construction projects are generally designed in northing, easting, and elevation (or X,Y,Z) Cartesian 
coordinates. A GPS site calibration ties the GPS positions to the local site coordinate system so that 
GPS can be used to measure or stake out on the construction site. The site calibration process 
involves measuring a number of known control points in the local site coordinate system using a 
GPS rover, allowing the software to create pairs of measured latitude, longitude, height, and known 
control points.

To calibrate the site:

 1. From the Home menu, select GPSand then tap Site Calibration.

 2. If you have no control points in your site, you are prompted to enter a coordinate for where 
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you are standing.  The software computes a “one point” calibration based on this coordinate:

 3. If control points exist in your site, you are prompted to select a control point and then measure 
the physical point on the ground with your rover receiver.  To add a calibration point, tap Add 
Point:

 4. When enough control points have been measured, horizontal and vertical residuals will appear 
on the screen.

 5. If these are acceptable, tap Finish to end the calibration.  The calibration is then used for the 
site.

The site calibration is stored in a DC file that can be used with other Trimble equipment working on 
the project. The software can also export the site calibration to a CompactFlash card as a CFG file for 
use with Trimble GS900 machine control systems. 
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The software notifies you after three points have been measured whether the calibration is in or out 
of tolerance with respect to the calibration tolerances. After each point you have the following 
options:

 l measure additional points

 l retake a point flagged as potentially in error

 l save the partial calibration and resume later

The danger of using residuals as the only means of controlling a calibration is that the best 
precisions can be achieved using the wrong combination of points in the calibration solution. When 
an inclined plane is in use, this manipulation of residuals can result in a steeper tilt of the plane to 
best fit the data, resulting in better precisions and an in-tolerance calibration. Monitor the tilt of the 
plane closely, especially when the geometry of the control points is not strong. Widespread control 
that covers the entire site is good; narrow-based control around a corridor is not as good. An 
incorrect tilt of the plane can result in increasing errors in height as you move away from the center 
of the controlled area.

Performing a two-point calibration
Trimble recommends that wherever possible you use a multi-point calibration. Use the two-point 
calibration method in situations where a baseline of only two control points is available. In the two-
point calibration, the first point establishes the position and elevation for the project; the second 
point establishes the project orientation.

In a two-point calibration, the heights for the project are computed using a simple block shift 
method that ties all heights to the first measured control point. A two-point calibration is carried out 
in the same way as a multi-point calibration.

Troubleshooting a site calibration
If a site calibration fails repeatedly, try the following solutions:

 l Try a different combination of control points. The software cannot always identify the bad 
point.

 l Start the calibration process again. You may have incorrectly measured a point or points.

 l Check the equipment. The source of the error may be as simple as the adjustment of the rod 
bubble, or a bent rod.

Once the system is set up there are limited sources of error when using RTK GPS systems. The most 
common sources of error include:

 l A poor site calibration

 l Incorrect base antenna height

 l Incorrect rover antenna height

 l Incorrect selection of the correct antenna type at the base or rover, which causes height errors
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 l Incorrect location of the base station antenna

 l A GPS rod bubble is out of adjustment or the rod is bent

These errors can easily be detected by rechecking the system setup. After starting the rover each 
day, the software prompts you to recheck the system setup. All recheck system setup operations 
are logged in the work order report and record files for reference and troubleshooting 
requirements.

Measuring a new control point
There are several reasons why you may need to measure a new control point during a project and 
then add the measured position to the Control Point file for the site. Typical cases include:

 l When operating the project with a mixture of GPS and total station equipment; total stations 
require more control points around the project because of their line-of-sight dependence. 
Control points can be established very rapidly using GPS and can be used later by total station 
crews to establish their position and orientation.

 l When operating a site, a base station often needs to be moved closer to the current working 
location to provide better radio coverage. The base station must be relocated to a known point 
in the local coordinate system. Using the Measure control point option ensures that the point 
is created in the correct location, with the correct coordinates, and guarantees that the site 
calibration remains valid after the base station is moved.

 l When carrying out topographic measurements on a new site before control for the project is 
established, you may set the base station up in an arbitrary and convenient location and then 
carry out a single-point calibration. Once completed, measuring three or more control points 
around the project provides a common set of reference points that can be used later to 
transform the data measured using the single-point calibration, to the site coordinate system 
once it is established.

 1. From the Home menu, tap either GPSor Total Station and then tap Measure Control Point.

 2. Create the control point location using a stake, a hub, or a road nail as required and then mark 
the stake with the name for the control point, for example, STNQ.

 3. Set up the GPS rod over the point and hold it steady using a bipod. The software displays the 
current GPS position on the map.

 4. When you are ready to take the measurement, tap Measure. The measurement process takes 
approximately 15 seconds to complete. Measuring for 15 seconds takes an average position 
that increases the accuracy of the computed control point.

When each control point is measured, the software stores the control point data position in the 
control point (Control.csv) file for the site, and also records the measurement data into the record 
and report files for the work order.
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Measuring using xFill technology
The optional xFill™ option for SPS GNSS receivers allows maintaining an accurate positioning 
solution for an additional four minutes after the main correction data source has been dropped, for 
example, in a radio blackspot or in an area where no cell coverage is available when measuring with 
VRS™ technology.  During this time the receiver uses L-band based corrections. If the correction data 
source is restored during these four minutes, the xFill technology seamlessly drops in and out. 
Points measured with xFill technology are stamped as such as the accuracy decreases when coming 
closer to the four-minute mark. 

To use the xFill technology, the receiver needs to track the xFill satellite for at least 15 minutes.

Static measurements
If the receiver has the Data Logging  option installed, the software can configure an SPS GNSS 
receiver for static measurements.

To set up the receiver for static measurements:

 1. From the Home menu, tap GPS and then tap Connect. The following dialog appears: 

 2. Set the Mode option to Rover and then answer each question that appears to complete the 
setup.

 3. After setting up the receiver a message may appear asking if you want to calibrate the site; tap 
No.

 4. Change the measurement mode to Static; tap the  icon in the status bar to  then tap 

. The following dialog appears:
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 5. Complete the options for the antenna height, how long you want to measure for, and select 
whether or not to store the raw data in the receiver. You need to measure at least four minutes 
to store RAW data in the receiver, which can then be used for postprocessing.

 6. When you are ready to start the Static measurement, tap Measure. The software will count 
down the time that you have entered and then give you the option to fill in the point name and 
code and accept and store the measurement.
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In this chapter: 

 n Connecting to a total station

 n Leveling the total station

 n Establishing the station

 n Arbitrary location

 n Setting up on a known point

 n Reading station setup data from the total 
station

 n Completing a station establishment where 
the height of the setup point has not been 
determined

 n Working with a mechanical total station

To perform measurement or stakeout tasks, you 
need the SCS900 site controller software running 
on a controller that is connected to a positioning 
device. This chapter explains how to set up and 
use SPS Series total stations with the SCS900 
software.
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Connecting to a total station
When you start the software, it automatically looks for a connection to the total station through a 
cable connection. If the instrument is a robotic total station, the connection can also be made 
through the internal radio of the controller or an external 2.4 GHz radio. When the connection is 
made, the Level Compensator screen (see page 97) appears.

If you leave the controller in GPS mode, it cannot find the connection even if it is connected directly 
to a total station. If you are using Bluetooth wireless technology to connect to the total station 
(SPS700, SPSx10, SPSx20 or SPSx30), you must first turn on the total station, enable the Bluetooth 
connection using the face 2 display menu, and then manually force the connection to it.

If you are using a radio to connect to the total station, you need to manually force the connection 
to it.

To force a connection using either a radio or Bluetooth wireless connection:

 1. Go to the Trimble icon menu and select Total Station.

 2. Select Trimble as a Brand.

 3. Select SPS Series as instrument.

 4. Select Bluetooth or Radio.

 5. Select the Radio channel and Network ID.

 6. Follow the instructions that appear on the screen.

Leveling the total station
The compensator inside the total station provides dual-axis correction for any mislevel of the 
instrument during operation, for a working range of up to 6' of arc. The display enables you to level 
the total station accurately using the foot-screws on the tribrach:
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To level the total station:

 1. Align the front face of the total station with two tribrach foot-screws.

 2. Adjust the horizontal bubble in the display using those same two foot screws.

 3. Adjust the vertical bubble using the third foot screw.

 4. Once level, tap OK.

You can disable the compensator, however, only do this in extreme working conditions such as 
when working:

 l in close proximity to a piling rig, vibratory compactor, or other source of extreme ground 
vibration that would continuously affect the compensation effect on the total station.

 l on a mobile platform where the level is continuously changing, but where all measurements are 
needed in the reference frame of the platform itself, for example on a marine vessel or oil 
platform.

 l in extremely windy conditions where wind buffet on the total station is significant, and again 
would continuously affect the compensation of the total station.

If the compensator is switched off, the total station stops correcting for instrument mislevel. In 
these situations, watch and adjust the level on a regular basis. At this point, Trimble assumes that 
the total station is set up accurately over a known point (see page 100) or that you have set it up in a 
convenient location, and will establish its position using the Arbitrary location (see page 99).

Establishing the station
The total station position and orientation is necessary if the total station is to be used for site 
measurement or stakeout operations where the positions computed are related to a site coordinate 
system. There are two methods of establishing the position and orientation of the total station:

 l Arbitrary location  (see page 99) (also known as free station or resection)

 l Setting up on a known point (see page 100)

Once the station has been established, the total station can be used for measurement or stakeout 
operations. 

If you have not established the position of the total station and you select a measurement or 
stakeout function, the software automatically forces you into this process when connected to a 
total station. If you have not entered any control point data for the site, the station establishment 
process only allows you to set up at a manually entered coordinate location and orientation of the 
angle system to 0.0000 in a chosen direction. This method is acceptable only if you are measuring a 
new site that has not been measured before and provided that you are not trying to measure or 
stake anything from a loaded design. In most cases, you should have control points available.
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Arbitrary location
The arbitrary location setup enables you to set up the total station at a location that is convenient 
for the operation to be carried out (and not over a known point). It measures the angle and distance 
to two or more known points to determine the position and orientation of the total station.

 1. In the Total Station menu, select Station Setup. If you just connected to the total station, the 
software prompts you for the station establishment method. Select the Set up at an arbitrary 
location option:

 2. Add at least two control points:

The screen shows if the setup is within or outside the tolerance.

 3. Tap Accept to complete the instrument setup.
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Setting up on a known point
This enables you to set up the total station over a known control point location and then measure 
to one or more reference control points to establish its position and orientation on the jobsite. In 
most cases, a single reference control point may be all that is required. In other cases, where the 
accuracy of the work is higher, measuring more than one reference control point can provide better 
control over the orientation of the total station and a further check that the control point at the 
total station position or any of the measured reference control point locations has not moved.  
Unlike the arbitrary location method, once you measure a single reference control point, the 
information shown below appears on the screen. You can follow similar steps to those used in the 
arbitrary location method of station establishment. Select from one of the following options:

 1. From theTotal Station menu, tap . If you have just connected to the total station, 
the software prompts you to select the station establishment method. Select the Set up on a 
known control point option and then click Accept.

 2. Measure at least two or three control points using the Add button.

 3. Under Settings you can modify the station set up tolerances. By tapping Report you get more 
information about the quality of your station establishment.

 4. Add at least one control point:

 5. If you do not know the name of the reference point being selected when carrying out either 
station establishment process, simply move the target to the point that you want to measure, 
or point the total station at an already established target. The target indicator moves in the 
map to that location, making it easy to identify and select the correct point from the map view.

 6. The screen shows if the setup is within or outside the tolerance.

 7. Tap Accept if the total station set up is within tolerance.
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Reading station setup data from the total station
After you have performed a station establishment, the total station stores the information in its 
memory, so that other controllers running the software can access it. Subsequent users can save 
time by simply retrieving the station setup information from the total station’s memory without 
resetting up at an arbitrary location or on a known control point.

Completing a station establishment where the height 
of the setup point has not been determined
If the height of the total station has not been established at the end of the station establishment 
process, the software prompts you to either enter a known height for the setup point or to a height 
from a known benchmark location defined as a 1D or 3D point. This occurs when:

 l setting up at an arbitrary location, the reference control points measured were all 2D points.

 l setting up a known point, the known point and reference control points selected were all 
defined as 2D points.

The benchmark point is measured in the same way as any other control point. It is used in 
combination with the target height and instrument height to determine the setup point elevation.

Outputting data through the COM port
In some applications, it is useful to have the controller deliver the raw measurement  data or the 
computed coordinate data to the serial port of the controller, so that other  software, for example 
hydrographic positioning applications, can pick it up and use it.

To set up the COM port:

 1. Connect to the SPS total station and complete a station establishment. 

 2. From the Home menu, tap Total Station and then tap Settings. The Total Stations Settings 
dialog appears.
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 3. Tap the Settings tab: 

 4. Enable the Raw data output option.

 5. In the Output format list, select either HAVASD raw data or XYZ coordinates.

RAW data format Coordinate data format

0 0
7 = HA 37 = Northing
8 = VA 38 = Easting
0 = SD 39 = Elevation
The first line of data is always a 0, which is a status tag indicating a complete measurement record.

Each line of data is terminated with a carriage return and line feed.

 6. In the Output mode list, select either the After recording (every time you tap Record) option or 
the Continuous (every time the total station has a new measurement) option.

 7. In the COM Port list, select the controller port through which to send the data.

 8. In the Baud rate list, select the rate in bits per second that you want to send the data to the 
COM port.

Note – Parity is set to 0 (No Parity), data bits is set to 8, and stop bits is set to 1. You cannot 
change these settings.

 9. Tap OK. Once the connection is established, and measurement commences, the data will be 
sent to the selected COM port in the format you selected.
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Computing the total station scale factor
The software can calculate a projection scale factor using a preselected coordinate system or site 
calibration in the site folder, for example, to measure accurately in a zone of the UTM coordinate 
system. 

To enable the automatic project scale factor:

 1. From the Home menu, tap Total Station. 

 2. Tap Settings. The Total Stations Settings dialog appears.

 3. Tap the Corrections tab: 

 4. You can enter a fixed scale factor, leave the scale factor at 1, or let the software calculate a scale 
factor based on the site calibration. The software uses the instrument coordinates resulting out 
of the station establishment to calculate the correct scale factor for this instrument location in 
the selected coordinate system zone.

Once the option is set to Computed and site measurements have been taken, the Computed 
option is locked to guarantee the consistency of the measurements.

The automatic scale factor is also written to the instrument scratch pad to apply it for machine 
control operations with the GCS900 or AccuGrade grade control systems.
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Working with a mechanical total station
In addition to the Trimble SPS series of total stations, the software also supports  Nikon® and 
Trimble mechanical total stations. Most of the functions work exactly like when using a robotic total 
station.

 1. Set up the total station over a known point and then level it using the bubble and electronic 
level of the instrument.

 2. Enter atmospheric and other distance correction values using the instruments' on-board 
software.

 3. Select the method of the station establishment and proceed as described in this chapter.

Measuring with a mechanical total station
Measuring with a mechanical total station works exactly the same as using a robotic total station. 
Walking and Vehicle mode are not available with mechanical total stations.

Staking with a mechanical total station
Guidance to a stakeout point works similar to staking with a robotic total station. An additional 
arrow on the top right of the Measurement screen indicates how many degrees you need to 
manually turn the total station until reaching the direction of the stakeout point.

 

After the person on the rod was brought in line with the total station, the total station button on 
the bottom right will take a measurement. The distance to the point which should be staked is 
indicated in the Info bars. Make sure you have GO, horizontal, and vertical angle turned on in the 
info bar.

Once the rod is within the stakeout tolerance, tap the button with the stakeout flag to stake the 
point and receive the stakeout report. The software creates a Stake Marker report. A graphical 
diagram shows how to put an elevation mark on the stake. The way the software calculates the 
elevation mark and cut/fill depends on the Stakeout Settings in the Trimble icon menu.
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In this chapter: 

 n Setting up for machine control

 n Machine measure-up for concrete paver
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Setting up for machine control
From the Home menu, tap Total Station / Machine Control Setup:

If the instrument has the OEM option installed, an OEM Mode is available. To set up the instrument 
for a Trimble GCS900 machine control system, select Machine Control Mode.

Defining the window for Full Search mode
Define the window for the Full Search mode:

 l Accommodate the fact that the prism can be mounted on an electric mast, and that the 
window of operation at close range will be higher or lower than at longer ranges.

 l Ensure that you set the window of operation to cover the extents of all grading operations to 
be completed from that location (instrument setup).

 l Ensure that if the machine is taken outside that window, to turn around or to bench on a 
known height point, those locations are also included in the search window.

You can define either the upper left/lower right extents of your search window or the upper 
right/lower left extents of your search window. Ensure that you take a good look at any high or low 
points in the area where you will be working and then define your search window to what most 
closely resembles the actual working area in front of you.

 l Point the total station to an upper left location and then to a lower right location; tap the 
appropriate Set button at each pointing.

 l Point the total station to an upper right location and then to a lower left location, tapping the 
appropriate Set button at each pointing.

As soon as the first corner is defined, the only option available in the software is to define the 
opposite corner. For example, if you define the upper right extent first, the lower left corner only is 
made available to define. If the lower right corner is set first, then the upper left corner only is made 
available to define.
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A single SPSx30 total station can be shared by multiple machines and a single SPS robotic rover pole 
at, for example, at a bridge structure. Only one user can use the total station at a time, but when 
not in use, it continually scans a predefined list of radio channels assigned to different machines and 
the last used site positioning system channel in sequence, looking to see if anyone needs access to 
the total station. When a machine or site positioning system calls the total station, it connects and 
provides a positioning service. When completed, the total station returns to Standby mode and 
becomes available to the radio channels previously loaded to the instrument. To facilitate this 
process, in the set up for machine control process, you can create a list of machines, each with a 
name and a specified radio channel, for example:

 l CAT 140H Grader 1 33

 l CAT D6 Dozer 1 34

The machine list is scanned sequentially whenever the total station is placed in Standby mode for 
machine control. The more entries in the list, the longer the scan takes to complete a full cycle and 
therefore the slower the initial connection will be with the total station. If you are not continually 
using the entries in the list in earthmoving operations, delete the entries from the list to speed up 
initial connection times.

Tap Add to create a machine in the machine list, enter a machine name and assign a network 
channel. Also, select a Network ID for the instrument.
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This completes the instrument setup. The total station goes into Standby mode waiting for a 
machine to connect to it. Tap       Finish to confirm the machine control setup:

If you are tracking a machine and the target becomes lost for any reason, the total station continues 
to turn at a constant horizontal and vertical speed for a short period, in the expectation that the 
target will appear on the same trajectory when it clears the obstruction. A line-of-sight obstruction, 
a passing vehicle, or simply losing the target because of movement speed can cause the total 
station to lose the target. When the target is 'lost', that is, the above method failed to reacquire the 
target, the total station searches for the target. The total station has two search modes:

Mode Description

Quick Search  Initiated as soon as the target is 'lost'. This search is centered on the last known 
location, and inside a window defined by a horizontal angle width (for example, 
15°) and a vertical angle width (for example, 15°). The machine control software 
sets the values for the search window.

Full Search  This search looks inside a larger window, defined by the dialog shown previously. 
When the Quick Search mode fails to locate the target, the Full Search mode is 
initiated.
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If you are operating at the total station, point it at the MT900 target on the machine. When the 
machine connects to the total station, this speeds up the initial search and lock-on process for the 
total station as it instantly “sees” the target and locks to it. The total station goes into Standby 
mode for machine control and then it scans the machine list in chronological order until a machine is 
found calling the instrument on one of the channels. The software now disconnects from the total 
station. Move to the machine and initiate connection to the total station.
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Machine measure-up for concrete paver
The software enables you to measure up a concrete paver using a guided measure-up routine, 
export the data to a USB stick and then load it onto the machine.

To make the measure-up routine visible:

 1. Tap the Trimble icon menu, tap Settings and then tap Measure Settings. The following dialog 
appears:

 2. Select the Enable Machine Measureup option to put the measure-up option in the Measure 
menu:

For a detailed description on how to measure up the concrete paver, please refer to the Trimble 
PCS900 Paving Control Systems Installation Manual.
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In this chapter: 

 n Scanning stockpiles

 n Adjusting the total station

 n Measure Control Network

 n Measuring rounds of angles

Direct reflex (DR) technology is included in all 
SPSx30 Universal Total Stations as well as all 
SPSx20 Construction Total Stations. This 
technology offers many advantages such as 
stockpile scanning for accurate volume 
calculations.

The range varies depending on the total station 
you are using:

 n The SPS620 and SPS720 total stations offer 
DR Standard technology, which enables you 
to measure reflectorless, to a maximum 
distance of 150 m (492 feet).

 n SPSx30 total stations offer DR+ technology, 
allowing reflectorless measurement of 
objects up to 1,600 meters  (5,249 feet) from 
the instrument.
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Scanning stockpiles
The Stockpile scan is designed to collect very accurate data for reporting on the volume of material 
that you have or that you have excavated. By scanning the stockpile or excavation, the need to 
place a worker in potentially unsafe conditions is eliminated. Reflectorless measurement technology 
enables you to set up the total station and measure to surfaces without using a target or prism.

Given the line-of-sight restrictions when using a total station, you need to perform a minimum of 
two station setups to collect all sides of the stockpile:

 1. From your first setup, measure new control points around the stockpile in locations that will 
give you  the fewest setups and the best vantage points to scan the largest surface area of the 
stockpile. This enables you to collect all sides of the stockpile and have the surface points 
correctly related to each other. 

 2. Once the whole stockpile has been scanned, define a volume boundary in the Volume & Cogo 
menu by tapping the points to be used to define the boundary, and then perform a volume 
calculation in the field.

To set up stockpile scanning:

 1. From the Home menu, tap Total Station and then tap Stockpile Scanning.

 2. The software sets the instrument to DR mode, and then the following screen appears:

 3. Define the shape of your stockpile. Start by tapping the gray dot at the highest point of the 
stockpile image on the screen.

 4. Manually sight your instrument to the highest point of the stockpile and then tap Measure. 
The Point Mode dialog appears.

 5. If required, enter a point code and point name and then tap OK.  The Stockpile  Scanning Setup 
dialog reappears.

 6. Repeat Step 4 through Step 6 to define the bottom left, bottom right, and bottom most points 
of your stockpile. Once successfully measured, the points appear green:
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 7. Tap Next. The Stockpile Scanning Settings dialog appears:

 8. Enter a point name and code and set the distance intervals. Setting the distance intervals low 
results in more measured points; setting the  distance intervals high results in fewer measured 
points. When entering these values, keep the size and shape of the stockpile in mind.  Define 
your minimum and maximum distances and then tap Next. Correct use of these settings helps 
you collect only relevant points in the field. The software will default to the recommended 
Timeout value depending on which instrument is being used.

 9. The Scanning Area Estimates dialog displays the total number of points to be collected as a 
result of the dimension and distance intervals previously entered and an estimation of  the time 
it will take to record the points. This time is an estimate only and the  reflectivity of the material, 
distances involved, and the type of instrument used alters the total time once the scan has 
started.
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CAUTION – The values stored in Step 8 are overwritten by the minimum and maximum values set in the  DR 
Target Settings dialog. Ensure that you check the values set in the DR Target Settings dialog to eliminate 
confusion by another operator when they are setting the Stockpile  Scan settings. Setting the minimum 
distance to 2 meters (6.56 feet) and maximum distance to 1600 meters (5,249 feet) in the DR Target 
Settings dialog will eliminate any errors when setting the Stockpile Scan settings.

Tip – When working at the maximum ranges of the DR technology, increase the Timeout Setting. When adjusting 
the timeout settings, be aware the material being measured affects the strength of the response signal. Also, the 
instrument's technology affects the time it takes to record each individual point.

 10. Either tap Esc to go back and change any settings before starting the scan or tap Start to start 
the scan.

 11. A grid is displayed as the scan proceeds. Scan time remaining is displayed in the  Estimated Time 
Remaining field. If you need to change the minimum and  maximum distance settings, tap 

Pause and then tap  . Change the minimum  and maximum settings and then tap Next. 
The scan will resume.

 12. Tap    in the map control bar on the left to display the map view so you can see the 
points being collected.

Tip – For an explanation of the different grid sector colors, tap    in the upper right of the screen. The 
following screen appears:
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 13. To rescan any cells, tap OK to return to the  measured cells display. Tap the  associated grid 
sectors with your stylus. Selected sectors turn blue. Once the  selection is made, tap Rescan. 
Repeat the rescan function until results are  satisfactory and then tap Finish.

Adjusting the total station
All total stations require regular and routine checks and adjustments to deliver optimum results. All 
Trimble total stations allow fully  accurate measurements to be made with a single  pointing to a 
target. To achieve that, the total  station stores its current adjustment values  internally, and then 
corrects all measured data  accordingly. For accurate measurements to be  made, the current 
adjustment values need to be determined and stored in memory. Total station  adjustments are 
required because of the optical  mechanical design of the instrument. The  following conditions can 
move the optics and mechanics out of adjustment:

 l Shipping and handling

 l Bumps and knocks

 l Temperature and pressure changes

 l Storage conditions

 l General wear and tear of mechanics
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To start the calibration:

 1. From the Home menu, tap Total Station / Total Station Calibration.

Compensator Calibration

CAUTION – You must perform this calibration before the HA VA Collimation and Tracker Collimation. The 
compensator does not need to be calibrated every time the other collimations are performed, but if the 
Compensator Calibration is performed, you should immediately perform the HA VA Collimation and Tracker 
Collimation. Performing the Compensator Calibration negates the validity of the values of the errors found 
from previous HA VA Collimations and Tracker Collimations.

The SPS family of motorized total stations is all equipped with a dual-axis compensator. The 
compensator is active when the total station is switched on. You should periodically calibrate 
the compensator to adjust for any minor changes in the total station caused by normal wear 
and tear, as well as shipping or temperature  variations. It is extremely important to perform 
this calibration when you are working  within a very tight tolerance range. You should also 
perform this calibration whenever the highest accuracies are needed.

 2. Tap Start to initiate the instrument Level Compensator Calibration:

 3. Tap OK.

HA VA Collimation test
You should perform this test to a target that can be easily bisected with both the horizontal 
and vertical cross-hair, placed at a location at least 100 m (328 feet) from the total station, and 
at approximately the same elevation as the total station telescope. The target can be any 
object including a road sign, window frame, or an adhesive prism target. The test involves 
taking a series of HA VA measurements to the target in both instrument faces, to generate a 
mean or averaged pointing in face 1 and face 2, from which the difference between face 1 and 
face 2 readings can be determined. The difference between the two face readings is known as 
the collimation error. In the horizontal axis, the collimation error has little effect on 
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measurements. However in the vertical axis, if not corrected for, the collimation error will result 
in erroneous elevation values for all measured points.

 4. Enter the number of measurements, aim at the target and then tap Measure:

The collimation test computes the collimation error, stores the error inside the total station 
and then corrects all subsequent measurements for that error before displaying them on the 
screen or storing them in memory.

 5. Tap Next.

Tracker Collimation test
You should perform this test towards a prism or active target set up at a distance of around 100 
m and at approximately the same elevation as the total station telescope. Ideally, perform the 
test at the approximate range that subsequent measurements will be made.

The test involves the total station locking onto and measuring an average position over a 
period of time in both faces to determine any misalignment of the tracker in relationship to the 
telescope cross-hair. If not corrected for, this error results in erroneous position determination 
in both horizontal and vertical axes, and also between measurements made with and without 
Autolock technology. Once measured, the error is stored in the total station, and is used to 
correct all subsequently measured positions.

 6. Aim at the target and tap Measure:
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Note – There can be two reasons for significant change between old and new values: The total 
station has received a knock or bump in transit that may need a service correction. There has 
been an observation error.

If you suspect an observation error, repeat the process. If the values are repeated, you may 
want to contact an authorized Trimble Service Center for advice. When the values exceed a 
certain level, you will be advised to send the total station to an approved Trimble Service 
Center for recalibration.

Note – The values displayed when new will be close to zero, but over time these are expected 
to change. Non-zero values are no cause for concern; however, sudden large changes should 
be cause for concern because they indicate misuse, abuse, or transportation problems. For 
full details of the instrumentation errors, refer to your instrument manual.

 7. Tap Finish.

Measure Control Network
The SCS900 software includes the Measure Control Network function, which enables you to 
configure and measure rounds of angles to different control points of a network or traverse. When 
you measure at least two rounds to a control point, the software will calculate the standard 
deviation for each foresight and backsight target (accuracy) and the standard deviation of the mean 
(precision). This enables you to evaluate the quality of the measurements in the field.

To use this function, you must purchase the Advanced Measurement module. When connected to 
an SPS instrument, the Enter / Measure Control Points function in the System Setup contains a new 
option called Measure Control Network. To adjust the traverse or control point network, you 
require the Total Station Processing module for Business Center – HCE. The SCS900 software exports 
the RAW data to a DC file, which is then imported into the Business Center – HCE.
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Measuring rounds of angles
To start the network measurement:

 1. Open a site and work order that contains your existing control points and connect the 
controller to an instrument.

Optionally, you can perform an instrument setup before starting the network measurement. 
This enables you, during the configuration of the network measurement, to check the point 
locations to verify if the prisms were set up over the correct control point.

 2. Tap Home / Total Station / Station Setup / Measure Control Network.

 3. Use the following screen to configure the measurements for a control point:

 4. The Network Measurement dialog contains the following buttons:

Tap this button …… to …

add a new point to the list

measure and add a foresight point to the list

check a point location.

edit point information.

delete a point from the list.
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Tap this button …… to …

delete all points from the list.

edit the settings for network measurement.

 5. To add an instrument point followed by all the backsight points for your setup, tap 

.

If the Control Point is not included in the Control Point file yet, then enter the coordinates in 
the following dialog:
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 6. In the Measurement Information group, you can decide if an individual control point should 
only be measured reflectorlessly or angle only, and can enter the correct target height, target 
type, and target ID.

 7. When checking Autolock the instrument will lock on the prism automatically after the first set. 
If you leave this option unchecked you will have to manually aim the total station at the prism 
each time.

Tip – When adding the next point, tap Use Last Settings to copy the settings from the previous point so that you 
do not have to re-enter all the values.

 8. To add and measure new control points as foresight points, tap   . To configure the 
point, see Step 4 through Step 5.

 9. If required, tap     to check the point location of an individual point from the list and 
verify that the prism is set up over the correct point.

 10. Tap   to edit the configuration of each point or tap   to delete it from 
the list completely.

 11. Once the configuration is correct, tap Next:

 12. Tap  to configure the face and round order as follows:

Tap… to…

F1 all targets only in face 1.
F1 F2 all targets only in face 1 first and then swaps in face 2 and measure all targets again.
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Tap… to…

F1/F2 each target in face 1 and then face 2 before going to the next target.
123...123... all targets in face 1 from left to right then swap in face 2 and measure from left to 

right.
123...321... all targets in face 1 from left to right then swap in face 2 and measure from right to 

left.

 13. To calculate the standard deviation for each target, measure at least two rounds.

 14. Tap Next and then tap Next again to access the Measurement screen. The SCS900 software 
prompts you to aim at the different targets and measure the first set. To measure the 
remaining sets automatically, enable Autolock.

 15. While measuring the second set, the software indicates the differences between face 1 and face 
2. If the measurements are within the tolerances that were entered for the differences between 
face 1 and face 2, the software shows the status “PASS” for that point.

 16. When all of the rounds are measured, the software shows the Standard Deviation of 
Measurements, which is an indication for the accuracy of all of the measurements. The 
Standard Deviation of the Mean gives an estimate of the precision of the measurement.

 17. The next screen shows the differences between the measured rounds for each target:
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 18. The next screen allows you to select which control points should be stored in the Control Point 
file of the site. The coordinates are a result of the average angle and distance measurements on 
one control point, but they do not take a traverse or network adjustment in account:

 19. Once all measurements and all control points are measured, you can export the RAW data of 
the measurements for doing a network adjustment. Select Home – Export / Import – Measured 
Data. To adjust the network in the Business Center software, export the data with the Network 
Measurement (DC) option. An export for StarNet network adjustment software is also 
available. Use the Network measurement (XSLT). The files with the raw data are stored in the 
Output folder of the current work order.
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benching Benching is a process of aligning your GPS position (latitude, longitude, and height) to a 

benchmark that has been added as a reference point. The calibration offsets your GPS 
position to that of the benchmark, improving accuracy and providing a point that you 
can return to later.

AutoBase AutoBase technology uses the position of the receiver to automatically select the 
correct base station; allowing for one button press operation of a base station. It 
shortens setup time associated with repeated daily base station setups at the same 
location on jobsites.

base station Also called reference station. In construction, a base station is a receiver placed at a 
known point on a jobsite that tracks the same satellites as an RTK rover, and provides a 
real-time differential correction message stream through radio to the rover, to obtain 
centimeter level positions on a continuous real-time basis. A base station can also be a 
part of a virtual reference station network, or a location at which GNSS observations 
are collected over a period of time, for subsequent postprocessing to obtain the most 
accurate position for the location.

DGPS See real-time differential GPS.
design map The map that provides live linework within a design for stakeout operations. The design 

map is a DXF file.
differential 
correction

Differential correction is the process of correcting GNSS data collected on a rover with 
data collected simultaneously at a base station. Because the base station is on a known 
location, any errors in data collected at the base station can be measured, and the 
necessary corrections applied to the rover data.
Differential correction can be done in real-time, or after the data is collected by 
postprocessing.

differential GPS See real-time differential GPS.
elevation (elev, elv) (1) Vertical distance (height) above or below mean sea level. (2) Vertical distance 

above or below the geoid. (3) Distance above or below Local Datum.
elevation mask The angle below which the receiver will not track satellites. Normally set to 10 degrees 

to avoid interference problems caused by buildings and trees, atmospheric issues, and 
multipath errors.

feature A feature is a physical object or event that has a location in the real world, which you 
want to collect position and/or descriptive information (attributes) about. Features can 
be classified as surface or non-surface features, and again as points, lines/breaklines, or 
boundaries/areas.

GLONASS Global Orbiting Navigation Satellite System. GLONASS is a Soviet space-based navigation 
system comparable to the American GPS system. The operational system consists of 21 
operational and 3 non-operational satellites in 3 orbit planes.

GNSS Global Navigation Satellite System.
GPS Global Positioning System. GPS is a space-based satellite navigation system consisting of 

multiple satellites in six orbit planes.
height It can mean a target height or antenna height ( for example, 2 m of rod height).
Here position An autonomous instantaneous position derived from the GPS receiver’s uncorrected 
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latitude, longitude, and height.
IBSS Internet Base Station Service. This Trimble service makes the setup of an Internet-

capable receiver as simple as possible. The base station can be connected to the 
Internet (cable or wirelessly). To access the distribution server, the user enter a 
password into the receiver. To use the server, the user must have a Trimble Connected 
Community site license.

Location GPS Location GPS covers decimeter to submeter GPS positioning techniques including 
Satellite Based Augmentation Systems (SBAS) such as WAAS, EGNOS, and MSAS), DGPS 
(reference station and rover operations), OmniSTAR VBS/HP/XP services, and Location 
RTK (decimeter-level RTK positioning).

Location RTK Some applications such as vehicular-mounted site supervisor systems do not require 
Precision RTK accuracy. Location RTK is a mode in which, once initialized, the receiver 
will operate either in 10 cm horizontal and 10 cm vertical accuracy, or in 10 cm 
horizontal and 2 cm vertical accuracy.

Precision GPS GPS positioning provided by techniques that typically deliver centimeter-level accuracy. 
These include RTK (Real-Time Kinematic) techniques and signals obtained from a VRS 
(Virtual Reference Station) system.

postprocessing Postprocessing is the processing of satellite data after it is collected, in order to 
eliminate error. This involves using computer software to compare data from the rover 
with data collected at the base station.

real-time differential 
GPS

Also known as real-time differential correction or DGPS. Real-time differential GPS is the 
process of correcting GPS data as you collect it. Corrections are calculated at a base 
station and then sent to the receiver through a radio link. As the rover receives the 
position it applies the corrections to give you a very accurate position in the field.
Most real-time differential correction methods apply corrections to code phase 
positions.
While DGPS is a generic term, its common interpretation is that it entails the use of 
single-frequency code phase data sent from a GNSS base station to a rover GNSS 
receiver to provide sub-meter position accuracy. The rover receiver can be at a long 
range (greater than 100 kms (62 miles)) from the base station.

Road job A road job is the term that defines a complete road model within the Terramodel and 
SCS700 software. It is a collection of roadway information that is expected to function 
together to define a roadway or a portion of a roadway between specific stationing 
limits. A road job contains the main alignment and all sub alignments, the road 
templates, and all the information used to define widening and super elevation for the 
road. A single project can contain multiple road jobs for different roads also contained 
within that single construction project.

road model

 

The road model used by the SCS700 software is a Trimble Terramodel PRO file. This file 
can be used for both staking and grade checking operations. The Road model is a 
template based model that provides full accuracy anywhere within the roadway 
surface.

rover receiver A rover is any mobile GNSS receiver that is used to collect or update data in the field, 
typically at an unknown location.

Roving mode Roving mode applies to the use of a rover receiver to collect data, stakeout, or control 
earthmoving machinery in real time using RTK techniques.
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RTK real-time kinematic. A real-time differential GPS method that uses carrier phase 
measurements for greater accuracy.

site A project that is to be worked on for a significant period of time. A site stores all design 
data and all executed work orders so you can easily find data whether you are in the 
office or in the field.

site map The site map within the SCS900 software is stored as a part of the site data. The site 
map provides linework as a reference only and is not live, which is why you cannot 
select it for stakeout purposes.

station A station is the running distance along the centerline or road that starts at 0.0 and 
increments as you proceed along the route. This term is used primarily in the US, 
whereas the equivalent term chainage is used throughout many other areas of the 
world, such as Australia, Asia, Europe, and New Zealand.

surface model The surface model used by the SCS700 software is a Trimble Terrain Model file (TTM 
file). It provides a 3D surface model that can be used for stakeout or grade checking 
operations.

work order A work order covers a task to be performed by a crew on a single jobsite. A work order 
contains the reference to the appropriate design, required settings and tolerances for 
the task, and a record and report of all the data measured or staked out in the process 
of completing the task.
A work order can cover a short-term task (such as the stakeout of a specific building 
pad) or a task that will last the duration of the project (such as the stakeout of storm 
water drainage) and that will be executed periodically as required during the project.
When the project is complete, all the information regarding the task is stored in a single 
file that is easy to recall.

Trimble SCS900 Site Controller Software User Guide 126


	USER GUIDE
	Safety Information
	Use and care
	Vehicle safety
	Servicing
	Accessories

	1   Introduction
	Related information
	Technical support

	2   Starting the Software
	System information

	3   Menus
	The Home menu
	The Site menu
	The GPS menu
	The Total Station menu
	The Import/Export menu
	The Measure menu
	The Stake menu
	The COGO menu
	The Exit menu

	4   Measurement screen
	Measure modes
	GPS measure mode
	Total Station measure mode

	Status bar
	GPS mode
	Total Station mode

	Precision GNSS control icons
	GPS mode

	Map options
	Map control
	Measure tab
	Design tab
	Layers tab
	Rotate tab

	Toggling between plan and cross section view
	Info bars
	Antenna Height / Target Height
	Trimble icon menu
	Measure menu
	Stakeout menu


	5   Data Management
	Sites, Designs, and Work Orders
	Avoidance zone settings
	Creating and opening a work order in the field
	Connected Community service
	Registering the controller
	Wireless Data Sync
	Remote Assistant


	6   Measurement Workflows
	Displaying cut/fill
	Checking a grade/elevation
	Checking material thickness
	Measuring a surface or a feature
	Measuring with feature codes – Advanced Measurement module required
	Photos


	7   Volume and COGO
	Compute Volumes
	Review & Edit Data
	Create Points/Arcs
	Create/Edit Roads
	Creating an alignment
	Creating a vertical alignment
	Positioning and creating templates
	Creating stakeout points

	Enter/Edit Stakeout Points

	8   Stakeout Workflow
	Points
	Stakeout Settings
	Measured Point
	Ground Surface
	Top of stake

	Lines
	Slope staking
	Reference Line
	Surfaces
	Planes
	Roads
	Roads
	Roadway feature staking
	Simple feature offset
	Custom feature staking
	Custom segment staking
	Catch point staking
	Location on Surface


	9   Measuring with GPS
	Setting up the GPS base station
	Setting up the GPS rover receiver
	Calibrating the site
	Performing a two-point calibration
	Troubleshooting a site calibration

	Measuring a new control point
	Measuring using xFill technology
	Static measurements

	10   Measuring with a Total Station
	Connecting to a total station
	Leveling the total station
	Establishing the station
	Arbitrary location
	Setting up on a known point
	Reading station setup data from the total station
	Completing a station establishment where the height of the setup point has no...
	Outputting data through the COM port
	Computing the total station scale factor
	Working with a mechanical total station
	Measuring with a mechanical total station
	Staking with a mechanical total station


	11   Machine Control
	Setting up for machine control
	Defining the window for Full Search mode

	Machine measure-up for concrete paver

	12   Advanced Total Station Features
	Scanning stockpiles
	Adjusting the total station
	Measure Control Network
	Measuring rounds of angles

	Glossary

